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Application destination type.

Added Gen Al Protect to "Data Loss Prevention" on page 107.

Added Control Browser Notifications to the Advanced Browser Settings in
"Web and Files Protection" on page 57.

Added Incognito Mode settings to the Advanced Browser Settings in "Web
and Files Protection" on page 57.

Added Managing Microsoft Sensitivity Labels for DLP in "Data Loss
Prevention" on page 107.

Added:

®  "Data Loss Prevention" on page 107.
® Data Loss Prevention column in “Introduction to Harmony Browse" on
page 14.

Added "Viewing Dashboard and Reports" on page 33.

Added Browser Status to the Table Filters and Column Description. See
"Viewing Computer Information" on page 42.

Added video tutorials for:

® "Upload Protection" on page 70.
® "Block Upload by Domain" on page 72.

Added "Custom Settings" on page 70.

Added video tutorial for "Upload Emulation " on page 58.
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® "Upload Emulation " on page 58.
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® Added support for Brave and Edge browsers on macOS. See
Browser settings in "Web and Files Protection"” on page 57 and the
OS, browser, feature compatibility matrix table "Introduction to
Harmony Browse" on page 14.

® Added new features:
o Sending monthly security reports. See "Sending Security
Reports" on page 171.
° "Reports Center" on page 172.

Added information about the new feature; Policy Mode. See "Configuring
the Threat Prevention Policy" on page 51.

Added new feature "Sending Security Reports" on page 171.

Added a new topic "Uninstalling the Harmony Browse Extension" on
page 174.

® Added information about the new feature; Scan local HTML files.
See "Credential Protection" on page 74.

® Added information about the new event; Accessing a local HTML
file. See "User Interface - Customized Browser Block Pages" on
page 50.

® Added information about Localizations supported by the Harmony
Browse extension. See "General Information” on page 149.

® Added a new field Upload and emulate files under to specify the file
size limit for Threat Emulation and Extraction. See "Download
Emulation and Extraction" on page 57.

® Added information about the new feature; Browser Extension
Pinning. See "Browser Settings" on page 101.

® Added a note about how to know the installed Harmony Browse client
version. See "Deploying Harmony Browse Clients" on page 22.
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® Added supported file types for Threat Emulation. See “Download
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Kingdom. See Registering to the Infinity Portal.

® Added information about the new feature; Malicious Script Protection.
See "Malicious Script Protection" on page 65 and "Introduction to
Harmony Browse" on page 14.

® Search reputation is now supported with Bing and Yahoo search
engines. See "Web and Files Protection" on page 57.

Updated "Browser Settings" on page 101 for the Brave browser.

Added support for the Brave browser on Windows. See "Introduction to
Harmony Browse" on page 14 and "Deploying Harmony Browse Clients" on
page 22.

Added a new topic "Managing loCs" on page 105.

® Added information about support for Threat Emulation appliance. See
"Download Emulation and Extraction" on page 57.

® Added sk179690 to verify whether the Harmony Browse client can
access the Check Point services and the stores of extensions. See
"Deploying Harmony Browse Clients" on page 22.

® Added information about the new "Web and Files Protection"” on
page 57.
® Added three new options for "Web and Files Protection” on page 57.

Added steps for installing the Harmony Browse extension for Safari. See
."Deploying Harmony Browse Clients" on page 22.

Added "Browser Settings" on page 101.
Updated Adding Exclusions to Rules

Added "Browser Settings" on page 101

Harmony Browse Administration Guide | 5


https://supportcenter.checkpoint.com/supportcenter/portal?eventSubmit_doGoviewsolutiondetails=&solutionid=sk179690&partition=Basic&product=Harmony
../../../../../../Content/Topics-Common-for-HEP/Adding-Exclusions-to-Rules.htm

Revision History

Date Description

1 February Updated:

2022 ,
Introduction

Creating a New Harmony Browse Management Service
Configuring Harmony Browse Policy
Configuring Client Settings Policy

Removed:

® Configuring Client Settings
® Viewing Harmony Browse Logs

30 January Added:

2022
® Managing Users in

Updated:

® |ntroduction
® Viewing Computer, Operational and Security Information
® \Web and Files Protection

Removed:

® Viewing Operational and Security Information

25 January Updated

2022
Viewing Computer Information

| |

® Adding Exclusions to Rules
® Managing Scanners

® Managing Virtual Groups

Removed:

® Active Directory Authentication
® Recent Tasks

16 January Updated:

2022
® Configuring Harmony Browse Policy

11 January Updated:

2022
® Client User Interface Settings
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Improved formatting and document layout
Updated:
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First release of this document

Check Point is engaged in a continuous effort to improve its documentation.

Please help us by sending your comments to our Technical Writers.
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Introduction to Harmony Browse

Introduction to Harmony Browse

Check Point Harmony Browse is a lightweight and easy to deploy solution which enables users
to safely access the internet, no matter where they are. It protects organizations and their
employees from web-based threats by preventing users from visiting zero-day phishing sites,
downloading zero-day malware, accessing non-compliant websites, and reusing corporate
passwords for non-business web content.

The product contains an on-cloud management system and a browser extension which
provides multi-layer browser protection capabilities.

Thre
at
Extra
ction
and
Emul
ation
Wind Chrom Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes
ows e
Edge Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes
Chrom
ium
Firefox Yes Yes Yes Yes Yes Yes No Yes Yes No
Brave3 Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes
Interne No Yes No No Yes Yes No No No No
t
Explor
er!
mac Chrom Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes
oS e
Firefox Yes Yes Yes Yes Yes Yes No Yes Yes No
Safari2 Yes No No No Yes Yes No No No No
Brave3 Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes
Edge Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes
Chro Chrom Yes Yes Yes Yes Yes Yes Yes Yes Yes Yes
meO e
S
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Introduction to Harmony Browse

Notes -

1 By default, the extension is disabled. To enable the extension, see Deploying
Harmony Browse Clients.

2 Browser extension is supported in Safari version 14 and higher.

3 Browser extension is supported in Brave version 1.43.89 and higher.

To set Harmony Browse, follow these steps:

1.
2.

Register to the Infinity Portal (see Registering to the Infinity Portal).

Register to Harmony Browse (see "Accessing the Harmony Browse Administrator Portal”
on page 17).

Create a new Harmony Browse Management Service (see "Creating a New Harmony
Browse Management Service" on page 28).

Deploy Harmony Browse clients (see "Deploying Harmony Browse Clients" on page 22).

Create a Harmony Browse Policy (see "Configuring the Threat Prevention Policy" on
page 517).
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Introduction to Harmony Browse

Getting Started

To get started with Harmony Browse:

1.

Create an account in Infinity Portal

. Accessing the Harmony Browse Administrator Portal

. Managing Licenses

2
3
4,
5
6

Creating a New Harmony Browse Management Service

. Deploying Harmony Browse Client

. Configuring Harmony Browse Policy

Creating an Account in the Infinity Portal

Check Point Infinity Portal is a web-based interface that hosts the Check Point security SaaS
services.

With Infinity Portal, you can manage and secure your IT infrastructures: networks, cloud, loT,
endpoints, and mobile devices.

To create an Infinity Portal account, see the Infinity Portal Administration Guide.
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Accessing the Harmony Browse Administrator Portal

Accessing the Harmony Browse Administrator
Portal

To access the Harmony Browse Administrator Portal:

1. Signin to Check Point Infinity Portal.

2. Click the Menu button in the top left corner.

CHECK POINT INFINITY PORTAL

3. Under Harmony, click Browse.

HARMONY

‘.’ Secure Users & Access

Connect
Endpoint
Mobile

Email & Collaboration

Browse

4. If you are accessing the portal for the first time, do one of these:
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\(

Welcome to @ serConer
Harmony Browse

YA
AL
v

® |f you already have a Check Point contract, click Already have a contract? to
attach the contract to the product. For more information, see Associated Accounts
in the Infinity Portal Administration Guide.

® |f you want to trial the product, click Start free trail.
If you have already attached the contract with the product, the Overview page appears.

Harmony Browse creates the endpoint management service automatically.
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Managing Licenses

Managing Licenses

User Center

When you create an account in the Infinity Portal and access the service, you get a free 30-day
trial. After the 30-day trial period, you must purchase a software license to use the product. To
purchase a license, you must create a Check Point User Center account.

Once you create a User Center account, contact your Check Point sales representative to
purchase a license.

To extend the trial period

1. Log into the Check Point User Center.

2. If you do not have a User Center account, go to My Check Point > My accounts and
create a new User Center account.

3. Go to My Check Point > Product Center.

4. Inthe Product Center, go to the Evaluations tab.

5. Select Other Evaluation Option and click Select a product.
The Other Evaluation Options window opens.

6. Select Harmony Browse - CP-HAR-BROWSE-EVAL from the drop-down list and
click Select.

Product Evaluation

THREAT PREVENTION EVALUATION ALL-IN-ONE EVALUATION ® SANDBLAST AGENT COMPLETE EVAL...
Evaluate all of the Threat Prevention Blades  Evaluate all of the Gateway and E\la‘luale Check Paint Maobile Data
on an existing Gateway Management Blades on any Gateway Pratection products
Other Evaluation Options ®
The following products are available for your evaluation: m
SandBlast Agent Complete Package-CPEP-SBA-COMPLETE-EVAL x|v

7. Click Next

8. In the Provide Evaluation Info section that opens, fill in these details:
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Managing Licenses

a. User Center Account
b. Email Address
c. Evaluation Product will be used by
d. Purpose of Evaluation
9. Click Get Evaluation.

A confirmation notice is received that the product was successfully added to your User
Center account.

Click the link in the confirmation notice to view the license in the Product Center.

Product Evaluation

o Congratulations! Your evaluation product has been successfully added to the specified UC Account.
An email with information about the evaluation has been sent to kobieb@checkpoint.com.

To license your evaluation product and enjoy a 30-day free trial:

1. Sign in to Check Point User Center with the User Center credentials.
2. Goto Froduct Cenfer and select the following account:

Mame: Kobie_CheckPoint

Aceount |0: 0008222543
3. Sele-::l lhe fullow-ng product in the Eva!mnmstab

Mame: SandBlast Agent Complete Pacl ge

SKU: CPEP-SBA-COMPLETE-EVAL

Certificate Key: E95D7DESB1DAS
4, Select the "license™ option and follow the licensing instructions.

To view this evaluation directly in Product Cente

Back to Product Evaluation

10. Inthe Product Center, go to Selected Account and select the account to which the
license was added.

11. Select the license and click the License button above the list of the licenses.

Product Center

:01‘u| e Products Blades Services Accessories  Evaluations Support Training
—

v Summary

« Details ., License & Maove 4, Multiple Move | & Attach Blades | ¥ Evaluate Blades | [l Export E

- SandBlast Agent Complete Package ®

Filter as you type ( E] showing 1 10 6 of 6 products
SKU EPSB-SM-COMF’LETE-LICENSE- Order 0B-JuL2020 - =

O Product Name £ VAL Date: . Purchased ¥ Comment # Renewal
Key: SBADCABEFFSD P adreas: Lo

Purchased: DB-Jul-2020
Account Info: Koble_CheckPoint 1D: 0008222563

1 SandBlast Agent Comelete Pac... < Description: SandBlast Agent Complete Package DE-Jul-2020

[l SandBlast Agent Comglate Pac... | Number Of Seats: 100 06-Jul-2020

Support; Mot covered by support - Gel Renewal Offer

Purchased; 10-Jun-2020 Annuity Services: [ ] [585] ¥ [T

| CPSE-EP-38-AB0T-EVAL ] " AQ-Jun-2020
: More Details .

[ [0l SandBlast Agent Comglete Pac... Gl - S——— e R U—— 10-Jun-2020

[} CPSB-EP-58-FRMC-EVAL CP3B-EP-3B-FRNC-... End Point Security 8222563 TIRIFZ A0=Jun-2020

12. Under License Information, select the License for Cloud Management checkbox.
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13.

Managing Licenses

My Products

CP-HAR-BROWSE-LICENSE- EVAL
403602D21A45

Harmony Browsing Security - browser extension security service for one user EVAL

Product/Feature Description 1P Address

CPSB-BROWSE

cense | Cancet_|

* - Required Fields

Click License.

Activating the License

To activate a license

1.

In Harmony Browse Administrator Portal, go to Global Settings > Services and
Contracts.

At the upper-right of the screen, click Link a User Center Account.
The Attach Accounts window opens.

Enter your User Center credentials, select the Account and click Next.
Select the license to apply and click Finish.

Your license appears in the Service and Contracts page.

o Note- If you already have an associated account and wish to add another

license, go to Global Settings > Service and Contracts. At the upper-right of

the screen, click Manage Accounts and use the sync option to refresh the
license.

To see your license information, go to the Endpoint Settings > Licenses.

To synchronize your license information, click Sync and then click CONFIRM.

Harmony Browse Administration Guide
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Deploying Harmony Browse Clients

Deploying Harmony Browse
Clients

o Notes -

® Harmony Browse automatically downloads and installs the latest version of the
Harmony Browse client on the endpoints. To know the version of the Harmony
Browse client installed on the endpoints, go to Assets Management >
Computers and see the Endpoint Version column in the table.

® For Mozilla Firefox users: If a user is accessing the browser for the first time
after installing the Harmony Browse extension, a consent page appears that
explains how user's personal information is collected, used, and protected. The
user must click Confirm to provide consent and activate the extension's
protection features.

To download the Harmony Browse client:
1. Click Overview and then click Download on the top banner.

2. Todownload the file immediately, click Download for the relevant OS and transfer the
file to the endpoint.

Client 0S Downloaded file
Browse Windows BrowserSetup.exe
macOS BrowserSetup.zip
ChromeQOS BrowserSetup _chromeQOS_laptop.txt or BrowserSetup
chromeOS_desktop.txt

To install the Harmony Browse client on Windows using .exe file:
1. Copy the latest BrowseSetup. exe to the endpoint.
2. Double click the BrowseSetup. exe file to install Harmony Browse.
3. Creating .msifile:
a. Select Start and type CMD.

b. Right-click Command Prompt and select Run as administrator.
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Deploying Harmony Browse Clients

c. Run:

cd <path to BrowseSetup.exe file>
d. Run:
BrowseSetup.exe /CreateMsi

The system creates the EPS . ms1 file.

To install the Harmony Browse client on Windows using .msi file:
1. Copy EPS.msi tothe endpoint.

Note - You can install Harmony Browse extension on the Internet Explorer
using the .msi file only.

2. Select Start and type CMD.
3. Right-click Command Prompt and select Run as administrator.
4. Do any of these:
® Run:
msiexec /i EPS.msi
® To install the Windows client with Internet Explorer extension, run:
msiexec /i EPS.msi no_ ie=false
B To install the Windows client without the Brave browser extension, run:
msiexec /i EPS.msi brave extension disabled=true

® To install the Windows client and setting the virtual group of the client, run:

msiexec /i EPS.msi virtual group name="virtual group name"

To install the Harmony Browse client on macOS:
1. Copy the zip file to the client.
2. Unzip the file.
3. Runthe app file.
4

. If you are using Safari, a prompt appears:

Harmony Browse Administration Guide |
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Deploying Harmony Browse Clients

In order 1o use Check Point Harmony Endpoint in Safan, please
download Harmony Browse Safari Extension from App Store

Open in App Store

Note - If you do not install the extension, the prompt appears every time you open Safari.
If you do not want to install the extension and stop the prompt, in the terminal window,
run:

sudo defaults write
/Library/Preferences/com.checkpoint.harmony.browse.helper mute
all prompts -bool YES

. Click Open in App Store and install the extension.

After you install the extension, a prompt appears.
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Deploying Harmony Browse Clients

In order to use Harmony Browse, please enable Harmony Browse
Extension in Safari Preferences.

Open Safari Extensions Preferences...

6. Click Open Safari Extensions Preferences.

G Harmony Browse 7.5.17 from Harmony Browse
| Protects users from advanced malware, phishing and zero-day attacks by
performing real-time analysis

Uninstall

Permissions for “Harmony Browse":

* Webpage Contents and Browsing History

u cards, and see you ory on the current tab's
webpage when you use the extension

Edit Websites... Always Allow on Every Website...

7. Select the Harmony Browse checkbox and click Always Allow on Every Website.

8. Go to Security & Privacy and click Full Disk Access.
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Deploying Harmony Browse Clients

Security & Privacy

General FileVault Firewall | Privacy

Allow the apps below to access data like Mail,
Messages, Safari, Home, Time Machine backups, and
certain administrative settings for all users on this
Microphone Mac.

Camera

Speech Recognition
@ CitrixEndpointAnalysis

(]
v Harmony Browse Helper

Google Chrome

.':' ~ Google Software Update

Accessibility

Input Monitoring

Full Disk Access

Files and Folders

Screen Recording

Q
i
®
L]
-
-
®
ip|

Media & Apple Music

é] Click the loc ant further ch: Advanced...

9. Select the Harmony Browse Helper checkbox.
o Note - To install Harmony Browse on Chromebook, see sk173974.

To verify whether the Harmony Browse client can access the Check Point services and the
stores of extensions, see sk179690.
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Deploying Harmony Browse Clients

Upgrading the Harmony Browse
Client (Windows only)

To upgrade the client:
® |nstall the .exefile for Windows. See "Deploying Harmony Browse Clients"” on page 22.
® Using a msifile:

1. Convert the exefile to msifile. See "Deploying Harmony Browse Clients"” on
page 22.

2. Run:

msiexec /i EPS.msi /gn && timeout /t 30 && msiexec /i
EPS.msi /gn
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Creating a New Harmony Browse Management
Service

After you register, Harmony Browse automatically creates a new management service.

For existing or old tenants that do not have a management service, you must create a
management service manually.

To create a management service manually:

1. Inthe Service Management view, under the Creating New Browse Management, enter
the information for these fields:

= Service ldentifier - Select your Endpoint Management Service nhame for this
account.

The Service Identifier:

» Must consist of 2-16 characters: uppercase letters (A-Z), lowercase letters (a-
z), numbers (0-9), or hyphens (-).

e Must not start with a hyphen (-).

® Hosting Site - The cloud location where the Harmony Browse Management
Service is deployed. This information is derived from your selection of data
residency region when you created the account. See Registering to the Infinity
Portal.

2. Click Create.
The deployment process initiates.

You can monitor the deployment process in the portal and an email is sent on completion.
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Managing Users in Harmony
Browse

After you create an account, you can create users who have access to Harmony Browse using
this account.

To each user you create, you must assign a user role.
Only User Admin can assign roles.
There are two types of user roles:
= Global roles.
When creating a new user, you must assign a Global role to the user.
® Specific Service roles.
Assigning a Specific Service role to a new user is optional.

Global Roles

Global Roles define the user's permissions to define user roles.

The Global Roles apply to the Infinity Portal platform and to all the services in the Infinity
Portal.

Currently, these are the supported Infinity Portal roles:

Role Description

Admin Allows Read & Write permissions across all services in your Infinity Portal
account.

When a new service is activated in your account, an Admin user
automatically gets Read & Write permissions in this service.

Read- Allows full Read-Only visibility to all services in your Infinity Portal account.
Only When a new service is activated in your account, a Read-Only user
automatically gets read permissions in this service.

User Allows management of all aspects of users and roles in your Infinity Portal
Admin account.

Only administrators with User Admin permission can access the Users tab
and associate roles with users.

Administrators with an Admin role and no User Admin role, cannot access
the Users tab.

You can assign multiple Global Roles to each user.
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Specific Service Roles

Roles which apply only to a specific service, in this case the role selected here applies only

to the Harmony Browse service. You can assign only one Harmony Browse role per user.

The Specific Service role selected overrides the assigned Global roles. There are 6 types of
specific Harmony Browse roles:

Admin

Read-Only User

Description

Full Read & Write access to all system aspects.

Has access to all system aspects, but cannot make any changes.

The table below summarizes the permissions of each user type:

Tab on

Section
Left Panel
Overview All Read & Read-
Write Only
Policy All Read & Read-
Write Only
Threat Prevention- | Read & Read-
Exclusions Write Only
Asset All Read & Read-
Management Write Only
Computer Actions Read & Read-
(Delete computer Write Only
data)
Logs All Read & Read-
Write Only
Endpoint All Read & Read-
Settings Write Only
Service All Read & Read-
Management Write Only
Service Actions Read & Read-
(Restart, pause or Write Only

terminate the
service)
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To see the list of users and the roles assigned to them, go to the Global Settings view >
Users.

To create a new user:
1. From the left navigation panel, click Global Settings (at the bottom of the panel).
2. Inthe top left section, click Users.
The list of currently defined users appears.
3. From the top toolbar, click # New.
The Add User window opens.
4. Configure the required details:
® Name
" Email
" Phone
= User Groups

Global Roles

Specific Service Roles

o Note - If the user you wish to add is not registered in Harmony Browse, they receive
a registration invitation to establish login credentials for the portal.

5. Click Add.

Note: - To edit or delete a user, select the user and click Edit or Delete from the top
toolbar.
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Managing Accounts in the Infinity
Portal

You can create additional accounts for the same user.

To create an additional account for an user

1. Go to the registration page:

https://portal.checkpoint.com/register/endpoint

2. For each new account, use a different account name (Company Name).
To switch between accounts

At the upper-middle of your screen, near the name Harmony Browse, click the current
account and select the required account from the drop-down menu.

To add an administrators to an account

1. From the left navigation panel, click Global Settings (at the bottom of the panel).
2. Inthe top left section, click Users.
The list of currently defined users appears.
3. From the top toolbar, click # New.
The Add User window opens.
4. Configure the required details:
= Name
® Email
® Phone

= User Groups

Global Roles - select Admin or User Admin

oNote - If the administrator you wish to add is not registered in Harmony Browse,
they receive a registration invitation to establish login credentials for the portal.

5. Click Add.
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Viewing Dashboard and Reports

The Overview page shows a graphical summary of important information about the Harmony
Browse clients in your organization.

Dashboard

The Dashboard page shows a graphical summary of important information about the Harmony
Browse clients in your organization.

Custom Dashboard

The Custom Dashboard allows you to create personalized dashboards with widgets of your
preference and specify whether the dashboard should be private or public. Private
dashboards are available only for you to view whereas, Public dashboards are available for all
the users with access to the Overview page. However, only the owner of the dashboard can
edit it.

Blank dashboard allows you to create a new dashboard with available widgets. Browse
template allows you to customize the Dashboard.

Harmony Browse Administration Guide | 33



Managing Accounts in the Infinity Portal

Creating a Custom Dashboard

CLICK HERE

NEINONNEN N NGRS RN R |

1. Goto Overview and click + next to Custom Dashboard.

2. To create a new custom dashboard from scratch:

a. Hover over the Blank dashboard widget and click Add.

b. Inthe Dashboard name field, enter a name.
c. Click Add Your First Widget.
The Add Widget window appears.

3. To create a custom Dashboard:
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a. Hover over the Browse template widget and click Duplicate.
b. Inthe Dashboard name field, enter a name.
c. Click Add Widget.

The Add Widget window appears.

4. From the left pane, select the widget and click Add.

ADD WIDGET x

D Seorch b

Announcements
Type
Activity by browser Communicztizn
Shows total events by browser. N
escription

Shows informative information.

Announcements
Pre

Shows informative information.
Announcements

Data less prevention scanned files L] #: Data Loss Prevention [DLF] EA
Shaows the total scanned files sent to the OLP engine Diat3 Loss Prevention [DLP] EAWe sre happy to
introduce the new Data Loss Prevention...

DLP events by data types
This widget shows DLP download fupload events by data

types

#: Smart exclusions EA
Smart exclusions EAWe are happy to introduce

. . the new smart exclusions which is now apen for..
Endpoints by operating systems -

Shows the number of endpoints (Deskiops and laptops)

by their operating system.

o Note - The Add button is disabled if the widget is already added to the dashboard.

5. To add more widgets, click Add Widget and repeat step 4.
6. To delete a widget, on the widget, click ¢ and click Delete.

7. By default, all custom dashboards you create are set as Private. To make the custom
dashboard available to all users with access to the Overview page, from the Private list
on the upper-right corner, click Public. The system adds the dashboard under Public
dashboards for other users.

8. Click Save.

The dashboard appears under Custom Dashboard on the left navigation pane, and it is also
listed under My dashboards in the Custom Dashboard page.
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Managing a Custom Dashboard

1. Click Overview.

2. To edit a dashboard:

a. Expand Custom Dashboard.

b. Click : for the dashboard you want to edit and click Edit.

c. Make the necessary changes and click Save.

o Note - You cannot edit dashboards created by other users.

3. Todelete a dashboard, expand Custom Dashboard, click : for the dashboard you want
to delete and click Delete.

o Note - You cannot delete dashboards created by other users.

4. To hide a dashboard, expand Custom Dashboard, click : for the dashboard you want to
hide and click Hide. The dashboard is removed from the list under Custom Dashboard
on the left navigation pane.

5. To unhide a dashboard, click * , hover over the dashboard you want to unhide and click
Add. The dashboard is added to the list under Custom Dashboard on the left navigation
pane.

6. To duplicate a dashboard, click * , hover over the dashboard and click Duplicate.

Reports

On the Reports page, you can download the reports in the pdf format:
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® Security Checkup - Shows the latest security events.

® 2023 Security Checkup - Shows a summary of the security events reported by Harmony
Browse during 2023.

® Threat Extraction Report - Shows the insights on the downloaded files.

® Check Point Cyber Security Report - Shows the latest security trends as per Check
Point.

Generate Report

9000
CLICK HERE

NEINONNEN N NGRS RN R |

To generate a report:

1. Goto Overview > Reports > Generate Report.

2. Selectareport, click ¥~ and select Export Report.

The Export Report window appears.

EXPORT REFORT

3. Inthe Time Frame list, select Last day, Last 7 days, or Last 30 days.
4. Click Export.
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Scheduled Reports

Scheduled Reports allows you to automatically generate reports at the specified date and
time, and email it to the specified recipients.

o Notes:

® The report becomes effective 24 hours after you schedule it. For example, if you
schedule for a new report today for 02:00 PM, then it is enforced from the next day at
02:00 PM.

® This feature is not supported for Check Point Cyber Security Reports.

® For performance reasons, it is recommended to schedule reports to run in off-peak
hours. For example, during non-business hours.

® The default time zone for the schedule report is Coordinated Universal Time (UTC).
For example, to schedule the report at 1:00 AM EST, specify the time as 6:00 AM
(depending on Daylight Savings Time).
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To schedule a report:

1.

Navigate to Overview> Reports and do one of these:

® From the Scheduled Reports page, click Add and from the Name list, select the
report.

SCHEDULE REFORT

Mame: 2023 Web Activity Checkup =

Frequency: Diaily

Time: 00 ~ [ -| 00 - UTC Mow: 08:40

# The S5cheduled Report takes 24 hours to become effective after scheduling it.

= For performance reasons, it is recommended to schedule reports to run in off-peak

® The default time zone for the schedule report is UTC. For example, to schedule the
repaort 3 00 A EST, specify the Time as 6:00 A depending on Daylight Savings
Time

Cloze Schedule
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" From the Generate Report page, select the report, click %- and select Schedule
Report.

SCHEDULE REFORT - 2022 SECURITY CHECKUP

# The Scheduled Report takes 24 hours to become effective after scheduling it.

2. From the Name list, select the report.

3. From the Time Frame list, select the period for the report:
= | ast day
= | ast 7 days
= | ast 30 days

4. From the Frequency list, select the frequency to generate the report:
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® To generate the report everyday, select the day of the week.
® To generate the report weekly, select the day of the week.
® To generate the report every month, select the date.

5. Inthe Time field, specify the time for the system to generate the report and send it to the
recipients. By default, the time is in UTC. For example, if you want to generate the report
at 01.00 AM Eastern Standard Time (EST), you must specify the time as 06.00 AM UTC.

6. Inthe Recipients field, enter the recipients for the report.
7. Click Schedule.

The schedule is added to the table. The report becomes effective 24 hours after you
schedule it.

8. To edit a scheduled report, select the report in the table and click Edit.

9. To delete a scheduled report, select the report in the table and click Delete.

Announcements

The Announcements page shows the latest news and enhancements in Harmony Browse.
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Viewing Computer Information

Asset Management View

The Asset Management view shows information on each computer, such as deployment

status, active components on the computer, browser extension version installed on the
computer and more.

i .
eoooooofl

Member of

o Note - The General > Description at bottom pane shows the text entered in the
Active Directory for the asset. If no text is entered, it is blank.

Creating a Custom View

You can create a custom view with the filters and table column you specify.

To create a custom view:

1. Apply the filters and select the required columns for the table and click Update. For more
information, see "Table Filters and Column Description" on page 44.

2. From the View drop-down, click Save View.
The Save New View window appears.
3. Inthe View name field, enter a name for the view. For example, Active Laptops.

4. Inthe Select what will be saved in this view section, select the required checkbox:
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" Filters
®= Table Columns
5. Click OK.
6. To delete a Custom View:

a. From the View drop-down, go to Custom Views.
b. Hover over the custom view and click ¥ .

Status Icon

The icon in the Status column shows the client or computer status.

Status
Icon

Description

Indicates Active Directory scanner.

Indicates Harmony Browse client.

(] Indicates that the client connection is active.

Indicates that a new computer was discovered that has no client installed.

Indicates that the computer was deleted from the Active Directory or from the
Organizational Tree.

s

Filters

Use the Filters pane on the top of the screen to filter the information in the table.

To add filters:
1. Inthe Filters pane, click +.

2. Select the required filter or search for the filter using the Search bar. For information on
the filters, see "Table Filters and Column Description" on the next page.

3. Click Update.

The system updates the table automatically for the added filters.
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1.
2.
3.

4.

position.

Click Update.

Managing Accounts in the Infinity Portal

Click B on the top left header of the table.
To select the columns for the table, search and select the columns.

To change the column position in the table, drag and drop the column to the required

Tip - The URL in the address bar of the web browser captures the filters you specify for the
table. You can bookmark the URL to go to the Asset Management > Computers page and
view the table with the specified filters.

Table Filters and Column Description

Filter/Column
Name

Status

Computer Name
Domain Name

Endpoint
version

Operating
System

Device Type
Deploy Time
OS Build

Last Connection

Last Logged In
User

Virtual Groups

Description

Status of the connected computer. For more information, see "Status
Icon" on the previous page.

Name of the connected computer.
Domain name of the connected computer.

Harmony Browse installer version.

Operating System version installed on the computer.

Type of the computer (Desktop or Laptop).

Time when the client was installed on the computer.
Operating System build number of the computer.
Last connection date of the computer.

Last logged in user name on the computer.

Pre-defined and custom virtual groups of the computer.
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Filter/Column
Name

Description

Browser Status | Shows the browser and the Harmony Browse extension status on the
endpoint.
The supported statuses are:

® Not Installed -
° The browser is not installed.
o The browser is installed but not used.
° The browser is used but the extension is disabled by the
policy.

n . : Q@
Running - The extension was detected. For example,

indicates that the Edge browser is active and the extension on it
was detected.
® Not Running - The browser is active but the browser extension

is not detected. For example, “ indicates that the Brave

browser is active but the extension is not detected. Contact
Check Point Support.

® N/A - The installed browser extension version does not support
Browser Status.

0 Note - This is supported only with the Windows browser
extension version BROWSE_90.09.0033 and higher.

Working with the Computers Table

1. Hover over the column and click ﬂ
2. From the drop-down :

® To freeze the column, click Pin.

To unfreeze the column, click Unpin.

Open the filter for the current column, click Filter and select the values.

To hide the column, click Hide.
® To insert another column, click Add Column.

3. To adjust the column position in the table, drag and drop the column to the required
position.

4. To copy the value of a cell to the clipboard, hover over a cell and click Copy.

5. To copy the values of a row to the clipboard, hover over a row and click Copy row.
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Managing Computers

Select the checkbox to the left of the applicable computers and right-click to perform these
actions:

General Actions

View Computer Logs

You can view logs of computers based on it's IP address.

To view computer logs by it's IP address:
1. Go to Asset Management > Computers.
Select the applicable computer or user from the list.

From the top toolbar, click =-

L DN

Select General Actions > View Computer Logs.

The system opens the Logs menu and shows the computer logs.
Create Virtual Group

You can create a virtual group. See Managing-Virtual-Groups. htm.

Create and Add to Virtual Group

You can add computers to a new virtual group. See Managing-Virtual-Groups.htm.

Add to Virtual Group

You can add a computer to a virtual group. See Managing-Virtual-Groups.htm.

Reset Computer Data

When the Endpoint client is installed on a computer, information about the computer is sent
to and stored on the Endpoint Security Management Server.

Resetting a computer means deleting all information about it from the server.

Resetting a computer does not remove the object from the Active Directory tree or change
its position in the tree.

o Important - You can only reset a computer if the Endpoint client is not installed. If
you reset a computer that has Endpoint installed, important data is deleted and the
computer can have problems communicating with the Endpoint Security
Management Server.
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Computer reset:

® Removes all licenses from the computer.

Deletes Full Disk Encryption Recovery data.

Deletes the settings of users that can log on to it.

Removes the computer from Endpoint Security Monitoring.

Deletes the Pre-boot settings.
® Marks the computer as unregistered.

After you reset a computer, you must reformat it before it can connect again to the Endpoint
Security service.

You may decide to reset a computer if:
® The Endpoint client was uninstalled or the computer is re-imaged.

® |tis necessary to reset the computer's configuration before a new Endpoint client is
installed. For example, if the computer is transferred to a different person.

Delete

Removes the asset from the Local or Active Directory and adds it to Deleted Entities in the
Organizational Tree. This operation discards the assets license information. You can use
this operation when you remove an asset from your domain.

Note - If the Endpoint Security client is still installed on the asset, the client continues to
receive the updates from the Endpoint Security Management Server.

To add the asset back to the Active Directory, see Recover.
Recover

Adds the deleted asset back to the Local or Active Directory from Deleted Entities in the
Organizational Tree. The asset's status is not Active until its Endpoint Security client
connects and synchronizes with the Endpoint Security Management Server. You can use
this operation when you add an asset back to the domain.

Note - You can recover only a deleted asset.
Terminate

Warning - Removes the asset from the Harmony Endpoint management permanently. You
cannot recover a terminated asset. We recommend to terminate an asset only if it is
discarded or disposed or the Endpoint Security client is uninstalled.
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Directory Scanner

Harmony Endpoint can scan and import users, groups, Organizational units (OUs) and
computers from multiple supported directory domains. See Managing Active Directory
Scanners.
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Configuring Harmony Browse
Policy

The Harmony Browse security policy contains these components:

® Client Settings - including the blocking pages customization and the data sharing with
Check Point.

® Threat Prevention - which includes Web & Files Protection. The Threat Prevention policy
is unified for all the Threat Prevention components.

When you plan the security policy, think about the security of your network and convenience
for your users. A policy should permit users to work as freely as possible, but also reduce the
threat of attack from malicious third parties.

You can add more rules to each Rule Base and edit rules as necessary. Changes are enforced
after the policy is installed.

In addition, the Browse policy contains the Global Policy Settings (see "Configuring Client
Settings Policy"” on page 50) and the Deployment Policy (see "Deploying Harmony Browse
Clients" on page 22).
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Configuring Client Settings Policy

User Interface - Customized Browser Block Pages

Browser extension uses block pages to warn the end users about security incidents and
prompts for additional permissions. There are four events which trigger a blocking page:

1. Accessing a site that is blocked by URL Filtering policy - The block page blocks access to
the site and warns the end user that attempted to enter the site that it is blocked by the

policy.

2. Providing credentials in a phishing site - The block page warns the end user that itis a
phishing site and the user is therefore blocked from providing credentials there.

3. Using corporate password in a non-corporate domain - End users are warned that use of
corporate password in a non-corporate domain is prohibited, and that his/her corporate
password was just exposed.

4. Accessing a local HTML file without the permission by the browser extension.
The blocking pages above are customizable. The following can be changed per each of them:
1. Company logo (replacing the Check Point logo).
2. Blocking page title.
3. Blocking page description.

The user may preview the change before saving the policy by pressing the preview button.

o Note - The preview only works in the Chrome or Edge browsers, when the browser
extension is installed.

General - Share Data with Check Point

Clients can share information about detected infections and bots with Check Point.

The information goes to ThreatCloud, a Check Point database of security intelligence that is
dynamically updated using a worldwide network of threat sensors.

ThreatCloud helps to keep Check Point protection up to date with real-time information.
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Configuring the Threat Prevention Policy

A Threat Prevention Default Policy rule which applies to the entire organization is predefined in
your Policy tab.

Each new rule you create, has pre-defined settings, which you can then edit in the right section
of the screen.

The Threat Prevention policy contains device rules and user rules.

® You can use user objects only in the user policy, and you can use device objects only in
the device policy.

® There is no default rule for the user policy.

User rules override device rules.
® You can use the same group in user and device rules at the same time.

® |f a group contains both users and devices, the rule is implemented according to the
policy in which the rule is included.

To enable user policy, go to the Endpoint Settings view > Policy Operation Mode, and select
Mixed mode.

The Parts of the Policy Rule Base

Column Description

Rule The sequence of the rules is important because the first rule that matches
Number traffic according to the protected scope is applied.

Rule Name Give the rule a descriptive name.
Applied to The protected scope, to which the rule applies.

Web & Files | The configurations that applies to URL Filtering, Download Protection,
Protection Credential Protection, Safe Search and Advanced Settings.

The Threat Prevention Policy Toolbar

To do this Click this

Clone, copy, paste, and deleterules | t=coe- & copy =Pasc- &

SearCh Search for entity Q
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To do this Click this

Save, view, and discard changes
o Note - The View Changes
functionality shows the policy @ Save All Changes
type that was changed and the |
date of the change.

Unsaved Rules ' 1~

B View Changes

W Discard Changes

Policy Mode

Policy mode allows you to:

® Quickly configure a Threat Prevention policy by selecting a predefined policy mode
(Detect only, Tuning and Optimized). Check Point automatically sets the appropriate
operation mode (Detect, Prevent, Off) and Advanced Settings options for each
capability.

® Manually set the operation mode (Detect, Prevent, Off) and Advanced Settings options
for each capability (Custom).

o Notes:

® The Detect only mode provides the basic protection. We recommend that you
use the Detect only policy mode for the first few days to gather, monitor and
analyze the data. Based on the analysis, you must switch to Tuning, Optimized
or configure a Custom policy mode for enhanced protection. If you use the
Detect only policy mode for the Default settings for the entire organization
rule (default) for more than two days, the system shows a banner as a reminder
to configure a stricter policy mode.

@ The policy mode of Threat Prevention rule for Entire Organization is set to “Detect only”. It is recommended to harden the policy configuration! Show Policy lzemind me later or Dismiss

If you click Dismiss, the system stops the notification only for you while it
continues to appears for other users.

Detect Only
Mode

|
Used for more than 2 days

Monitor and
Analyze Data

System shows a
reminder banner

Switch to Tuning, Optimized or Configure a
Custom Policy Mode

Enhanced
Protection

® |f you modify a predefined policy mode, it automatically changes to Custom.
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To select a mode for a policy:
1. Go to Policy > Threat Prevention > Policy Capabilities.
2. Select the policy in the table.

3. Inthe Capabilities and Exclusion pane, from the Policy Mode list:
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® Select a predefined mode:
o Detect only
° Tuning

° Optimized

The table shows the appropriate operation mode set for each capability for a policy
mode.

Policy Mode

Capability

Detect only Optimized
URL Filtering | Detect Detect Prevent
Download Detect Detect Prevent
Protection
Zero Detect Detect Prevent
Phishing
Password Detect Detect Prevent
Reuse
Search Off Off On
Reputation
Force Off Off On
Safe
Search

Advanced Settings
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Policy Mode

Detect only

Optimized

URL Filtering

Download

Protection

Credential
Protection

Allow user to dismiss the
URL Filtering alert and
access the website is
disabled.

Under Categories, Service is
selected.

Under Malicious Script
Protection:

° Block websites where
Malicious Scripts are
found embedded in the
HTML is selected.

o Allow user to dismiss
the Malicious Scripts
alert and access the
website is disabled.

Under Supported files,
Emulate original file without
suspending access is
selected.

Under Unsupported files,
Allow Download is selected.

Under Zero Protection, Allow
user to dismiss the phishing
alert and access the website
is disabled.

Under Password Reuse,
Allow users to dismiss the
password reuse alert and
access the website is
disabled.

Allow user to dismiss the
URL Filtering alert and
access the website is
selected.

Under Categories, Service is
selected.

Under Malicious Script
Protection:

° Block websites where
Malicious Scripts are
found embedded in the
HTML is selected.

° Allow user to dismiss
the Malicious Scripts
alert and access the
website is selected.

Under Supported files:

o Get extracted copy
before emulation
completes is selected.

o Extract potential
malicious elements is
selected.

Under Unsupported files,
Allow Download is selected.

Under Zero Protection, Allow
user to dismiss the phishing
alert and access the website
is selected.

Under Password Reuse,
Allow users to dismiss the
password reuse alert and
access the website is
selected.

® Select Custom and set the operation mode manually. For more information, see
"Web and Files Protection" on page 57.

4. Click Save.

5. Click Save & Install.
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Updating a Predefined Policy Mode

Based on internal analysis and research, Check Point may suitably modify the operation mode
or Advanced Settings of a predefined policy mode. If a predefined mode is updated, a
notification appears.

Policy Mode Detact anly -

S21iNgs 9o Not match "L

T

tart only

1l oolicy mode Aliory Kaan
Lo U ¥ ALY LS LS L = =

® Click Align to accept the updates. The system automatically updates to the new settings
for the predefined mode.

® Click Keep to retain the current settings. The policy mode changes to Custom.
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Web and Files Protection
URL Filtering

URL Filtering rules define which sites can be accessed from within your organization.

To set the URL Filtering mode:
1. Goto Policy > Threat Prevention > Policy Capabilities.
2. Selectthe rule.
3. Inthe Web & Files Protection tab, under URL Filtering, select a mode:

® Prevent - The request to enter a site is suspended until a verdict regarding the site
is received. Access to the site is blocked if site matches one of the blocked
categories or the Deny List.

» Allows user to dismiss the URL Filtering alert and access the website.

» This option is selected by default. It provides the user with access to a
blocked site if the end user believes the verdict is unjustified. This option can
also be turned off through the Advanced Settings section.

® Detect - Allows an access if a site is determined as malicious, but logs the traffic.
= Off - URL Filtering is turned off.
4. For Advanced Settings, see "URL Filtering" on page 64.

Files Protection
Download Emulation and Extraction

Download Protection rules protects users from malicious content.
To set the Download Emulation & Extraction mode:
1. Goto Policy > Threat Prevention > Policy Capabilities.
2. Selecttherule.
3. Inthe Web & Files Protection tab, under Download Protection, select a mode:

= Prevent - Prevents the download if the file is either known to be malicious or
detected as malicious by the Threat Emulation.
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® Detect - Emulates original file without suspending access to the file and logs the
incident. The file is blocked if it is malicious or blocked by file extension (Advanced
Settings > Download Protection). If not, the file is downloaded before the
emulation is complete.

= Off - Downloads the file without protection.

4. For Advanced Settings, see "Download Protection" on page 66.
Upload Emulation

Upload Emulation uses Threat Emulation to analyze the files you upload to protected domains
to identify threats and mitigate them.

o Notes:

® This feature is not supported for Harmony Browse clients managed through the
Harmony Endpoint Administrator Portal.

® The domains may support multiple ways to upload a file. For example, clicking a
button to browse and upload the file or drag-and-drop the file. If you upload files
by drag-and-drop, the Upload Emulation feature operates in the Detect mode,
even if you set to Prevent mode.

CLICK HERE

NN NINENENINNW T E R TR e
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To enable Upload Emulation:
1. Navigate to Policy > Threat Prevention > Policy Capabilities.
2. Selecttherule.
3. Inthe Web & Files Protection tab, under Upload Emulation, select a mode:

® Prevent - Prevents the upload if the file is either known to be malicious or detected
as malicious by the Threat Emulation. To specify additional behaviors for the
Prevent mode, see "Upload Protection" on page 70.

® Detect - Allows the user to upload the files even if it is detected as malicious. The
incidents are logged.

® Off - Uploads the file without protection.
4. To specify the protected domains, in the Upload Emulation section, click Edit.
5. Click New.

6. Inthe Value field, enter the domain name or IP address of the protected domain. For
example, my-domain or 1.1.1.1.

7. Select the required action for Upload Emulation:

° Protected - Enables upload emulation.

° Not Protected - Upload Emulation is disabled.
8. Click Save.

9. To delete the domain, select the domain and click Delete.
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o
10. To add multiple protected domains, click = :

® To add a list of protected domains and set Upload Emulation as Protected, click
Import Upload Emulation and select the CSV file with protected domains.

® To add a list of protected domains and set both Password Reuse and Upload
Emulation as Protected, click Import All and select the CSV files with protected
domains.

11. To export the list of domains to a CSV file, click S

® To export only the domains with Upload Emulation set as Protected, click Export
Upload Emulation.

® To export all domains, click Export All.
The system exports the data to a CSV file.
12. Click OK.

13. For Advanced Settings, see "Upload Protection" on page 70.

Credential Protection
Zero Phishing

Phishing prevention checks different characteristics of a website to make sure that a site does
not pretend to be a different site and use personal information maliciously.

To set the Zero Phishing mode:
1. Goto Policy > Threat Prevention > Policy Capabilities.
2. Selecttherule.
3. Inthe Web & Files Protection tab, under Zero Phishing, select a mode:

® Prevent - If site is scanned and found to be malicious, access to it is blocked and
log of the incident is shown in the Harmony Browse web management log section.

® Detect - Anincident log is sent but access to the site is not be blocked. Also, the
site scan is silent (invisible to the user).

® OFF - Turns off the feature.

4. For Advanced Settings, see "Credential Protection" on page 74.
Password Reuse Protection

Alerts users not to use their corporate password in non-corporate domains.
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To set the Password Reuse mode:

1.
2.

10.

Go to Policy > Threat Prevention > Policy Capabilities.
Select the rule.
In the Web & Files Protection tab, under Password Reuse, select a mode:

® Prevent mode - Blocks the user from entering the corporate password and opens
the blocking page in a new tab. If you enable Allow users to dismiss the password
reuse alert and access the website, then it allows the user to dismiss the blocking
page and continue to enter the corporate password.

® Detect mode - The system does not block the user from entering the corporate
password. If a user enters the corporate password, it is captured in the Harmony
Browse logs.

® Off - Turns off password reuse protection.

To add domains to Password Reuse, click New

o Note - Make sure that the endpoint is added to the domain.

In the Value field, enter the domain name or IP address of the protected domain. For
example, my-domainor 1.1.1.1

Select the required action for Password Reuse:

o Protected - Blocks users from reusing the password of protected domain in other
domains.

° Not Protected - Allows users to reuse the password of the protected domain in
other domains.

Click Save.

To delete the domain, select the domain and click Delete.

=
To add multiple protected domains, click = :

® To add a list of protected domains and set Password Reuse as Protected, click
Import Password Reuse, and select the CSV file with protected domains.

® To add a list of protected domains and set both Password Reuse and Upload
Emulation as Protected, click Import All and select the CSV file with protected
domain.

To export the list of domains to a CSV file, click < :
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® To export only the domains with Password Reuse set as Protected, click Enable
Password Reuse.
® To export all domains, click Export All.
The system exports the datatoa CSV file.

11. For Advanced Settings, see "Credential Protection" on page 74.

Safe Search
Search Reputation

Search Reputation is a feature added to search engines that classifies search results based on
URL's reputation.

o Notes:

® |tis supported only with Google, Bing, and Yahoo search engines.
® To enable this feature, ensure that you set URL Filtering Mode to either
Prevent or Detect.

To set the Search Reputation mode:
1. Goto Policy > Threat Prevention > Policy Capabilities.
2. Selectthe rule.
3. Inthe Capabilities & Exclusions pane, select Web & Files Protection.
4

. Inthe Web & Files Protection tab, scroll-down to Search Reputation section and select
a mode:

® On - Turns on the feature.
B Off -Turns off the feature.

When you enable this feature, the icon across the URL in the search results indicate the
classification:

Icon Classification

| The website is safe.
Example:
W This website is safe
e mereennemp — e WIKD > INStAgram - §
Instagram - Wikipedia
Instagram is a photo and video sharing social networking service founded in 2010 by Kevin
Systrom and Mike Krieger, and later acquired by American company ..
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Icon Classification

%] The website is not safe.
Example:

Its (0.42 seconds)

W This website is not safe

@ Instagram

Create an account or log in to Instagram - A simple, fun & creative way fo capture, edit & share
photos, videos & messages with friends & family

The website is blocked by the Administrator.
Example:

W This website is blocked by your administrator
E————— ..
Instagram - Home | Facebook
Instagram. 60933247 likes - 123838 talking about this. Discover what's next on Instagram

Rating: 2.9 - 33,504 votes

o Note - If the Search Reputation cannot classify a URL, then it does not display an icon
across the URL. If you want such URLs to be classified and blocked, then enable the
Uncategorized checkbox in URL Filtering > Categories > General Use. The Search
Reputation classifies Uncategorized URLs as The website is blocked by the
Administrator.

Force Safe Search

Force Safe Search is a feature in search engines that acts as an automated filter for potentially
offensive and inappropriate content.

To set the Force Search Reputation mode:
1. Goto Policy > Threat Prevention > Policy Capabilities.
2. Selectthe rule.
3. Inthe Web & Files Protection tab, under Force Safe Search, select a mode:
® On - Hides explicit content from the search results.

® Off - User sees the most relevant results for their search, which may include
explicit content like images consisting of violence.

Main features:

® When ‘Force Safe Search’ is on, Harmony Browse turns on Safe Search on the
supported search engines.

® |tis supported with Google, Bing, and Yahoo search engines.
® Force Safe Search is off by default.

® Force Safe Search is supported with Google Chrome, and Microsoft Edge browsers.
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Advanced Settings
URL Filtering

Note - You must set the URL Filtering Mode to Prevent or Detect to set the
Advanced Settings.

Allow user to dismiss the URL Filtering alert and access the website - Allows user to bypass
URL filtering and access the website.

Categories

Harmony Browse categorizes websites and you can specify the categories that must be
blocked for the user. When you select a category, the URL Filtering rule applies to all sites in
the selected category.

To specify the categories to block:
1. Under Categories, select the category. For example, Bandwidth Consumption.

2. Click Show and then select the sub-category.
Deny List
You can specify specific URLs, domains or IP addresses you want to block or deny access to.

To add a domain or IP address to Deny List, click Show and add the URL, domain or IP
address.

o Notes:

® You can add the domain names manually or upload a CSV file with the domain
names you want to add to the Deny List.
® You can use * and ? as wildcards in the deny list.
» * js supported with any string. For example: A* can be ADomain or AB or
AAAA.
» 2 is supported with another character. For example, A2 can be A2 or AB or
Ab.
® You can export your deny list.
® |f you wish to completely block the domain www.test-domain.com, including its
sub-domains (sub1.test-domain.com, sub2.test-domain.com, etc’) and itis a
naked domain (test-domain.com, without the www), you need to add two values
to the deny list:
e *.test_domain.com
e test_ domain.com
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Malicious Script Protection

Malicious Script Protection scans Uncategorized websites for embedded malicious
JavaScripts. If the domain that hosts the script belongs to any one of these categories, then
the page is blocked and the event is logged.

® Anonymizer

® Botnets

® Critical Risk

® High Risk

® Medium Risk

® Phishing

® Spam

® Spyware

® Malicious Sites

® Suspicious Content

Note - Ensure that you set URL Filtering Mode to either Prevent or Detect.If it is set
to Prevent, the page is blocked and the event is logged. If it is set to Detect, the page
is not blocked and the event is logged.

To specify malicious script protection:

® To enable malicious script protection, select Block websites where Malicious Scripts
are found embedded in the HTML.

® To allow users to dismiss the malicious script security alert and access the website,
select Allow user to dismiss the Malicious Scripts alert and access the website.

Files Protection
General Settings
Emulation Environments

You can specify the size limit for files that must be sent for Threat Emulation. Files larger than
the specified limit are not sent to Threat Emulation.

Upload and emulate files under - Specify the file size limit for Threat Emulation. The default
file size limitis 15 MB. The maximum file size limit supported is 100 MB.

o Note - Increasing the file size increases the client processing and network
traffic required to process large files.
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Override Default File Actions

Harmony Browse allows you to override the default file action for the supported and
unsupported files.

To override the file action for supported files:
1. Inthe Supported Files section, click Edit.
2. Select the File action and Extraction Mode.

3. Click OK.

To override the file action for unsupported files:

1. Inthe Unsupported Files section, click Edit.

a. Toadd afile type, click * and enter the File type.

b. To edit afile type, select the file type and click =

e

c. Todelete afile type, select the file type and click u
2. Select the Download action for the file:
® Default - The action specified in "Unsupported Files"” on page 70.
= Allow
® Block
3. Select the Upload action for the file:
® Default - The action specified in "Unsupported Files"” on page 70.
= Allow
® Block
4. (Optional) In the Comments field, enter a comment.

5. Click OK.

Download Protection

Note - You must set the Download Emulation & Extraction to Prevent or Detect to
set the Advanced Settings.

Harmony Browse Administration Guide | 66



Web and Files Protection

Harmony Browse protects against malicious files that you download to your Endpoint. By
default, it sends the files for extraction and emulation to Check Point's Threat Emulation on the
cloud before they are downloaded to the Endpoint disk. You can also configure Harmony
Browse with Threat Emulation on-premise. For more information, see sk113599.

® Threat Emulation: Detects zero-day and unknown attacks. Files are sent to sandbox for
emulation to detect evasive zero-day attacks.

® Threat Extraction: Proactively protects users from malicious content. It quickly delivers
safe files while the original files are inspected for potential threats.

Supported Files

The supported file types for Threat Emulation are:
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Threat Emulation Supported File Types

7z
aspx
app
arj
bat
bz2
CAB
csv
com
cpl
dll
doc
docx
dot
dotx
dotm
docm
dmg
dylib
exe
gz
hwp

iSO

Ink
msi
msg
O
one
pif
pdf
pkg
ppt
pptx
pps
pptm
potx

potm

ppam
ppsXx
ppsm
ps1
qcow?2
rar

rtf

sh

scr

sldx

slk
swf
tar
tbz2
tbz
tb2
tgz
udf
uue
wim
wsf
xar
xlt
xls
xIsx
xIm
xltx
xlsm
xltm
xIsb
xla
xlam
xll

xlw
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img
iqy

jar

sldm

Xz

Zip

The supported file types for Threat Extraction are:

Threat Extraction Supported File Types

doc
docm
docx
dot
dotm
dotx
fdf
pdf
pot

one

potm
potx
ppa
ppam
pps
ppsm
ppsX
ppt

pptm

pptx

xls
xlsb
xlsm
xlsx
xlt
xltm
xltx

xlam

Web and Files Protection

o Note - Ignore the files types listed in the Harmony Browse Administrator Portal.

Download Emulation Actions

The options available for supported file types of Threat Extraction are:
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= Get extracted copy before emulation completes

o Extract potential malicious elements - While a file is tested, receive a copy of the
file with all suspicious parts removed. Files that support extraction are available for
download after the extraction. Files that do not support extraction are available for
download only after the emulation and if it is benign.

o To specify the elements for Threat Extraction in the downloaded file, click

Elements to extract and click + to add and click ¥ to remove.

o Covert to PDF - For receive the file in a PDF format. If the file is not malicious,
users receive the original file when the emulation is finished. Emulation can take up
to two minutes.

®= Suspend download until emulation completes - The original file is downloaded if found
to be clean.

= Emulate original file without suspending access - Emulates original file without
suspending access to the file and logs the incident. If the file is malicious, it is blocked.

® Allow - Threat Emulation and Threat Extraction is turned off.

Unsupported Files
The options available for unsupported files types are:
= Allow Download - Allows user to access the file.

® Block Download - Blocks user from accessing the file.
Custom Settings
Download Emulation and Extraction

®= Block downloads when emulation fails due to size limit or connectivity problem -
Select the checkbox to block download of a file if the Threat Emulation of the file fails due
to technical reasons, such as file size limit, no internet connectivity and invalid licenses.

®= Block downloads when emulation fails due to file encryption - Select the checkbox to
block download of a file, if the Threat Emulation of the file fails to extract the file due to

the file encryption.
Upload Protection

Harmony Browse protects against malicious files that you upload to the protected domains. By
default, it sends the files to Check Point's Threat Emulation on the cloud before they are
uploaded to the domains. You can specify the advanced settings for uploading files that are
supported and unsupported by Threat Emulation.

Note - This feature is not supported for Harmony Browse clients managed through
the Harmony Endpoint Administrator Portal.
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CLICK HERE

TO START THE TUTORIAL

Upload Emulation Actions

® For supported files:

o Suspend Upload Until Emulation Completes - File uploads to the protected
domains are suspended until the Threat Emulation analysis of the files is complete
and the verdict is benign.

o Emulate the file without suspending access and block known malicious files -
Malicious files are blocked and not uploaded to protected domains. Rest of the files
are sent to Threat Emulation for analysis without suspending the file upload.

o Emulate the file without suspending access - Files uploaded to the protected
domains are logged but not prevented. End user does not receive any notification.

o Allow - Disables the Upload Emulation feature. That is, allows users to upload files
to protected domains without Threat Emulation.

® For unsupported files:
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o Allow - Allows the upload of file types that are not supported by Threat Emulation to
the protected domain.

Warning - Uploading files without Threat Emulation analysis may pose
potential security risks.

o Block - Blocks the upload of file types that are not supported by Threat Emulation
to the protected domain.

Note - File type policy overrides the default file action selected here. For more
information, see "Override Default File Actions"” on page 66.

Block Upload by Domain

Allows you to specify domains to which you want to either allow or block upload files,
regardless of the Upload Emulation setting.

CLICK HERE

TO START THE TUTORIAL
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To block or allow files upload to a domain:
1. Navigate to Upload Protection.
2. Inthe Block upload by domain section, click Edit.

The Advanced Settings - Web & Files Protection window appears.

ADVANCED SETTINGS - WEB & FILES PROTECTION x

{ Back  Block upload by domain
Add domains to block uploads
+ 1 0/100 items

Domain Action

3. Click *

4. Inthe Value field, enter the domain name or IP address. For example, my-domain.com
or1.1.1.1.

5. From the Action list, select the required action:
® Block
= Allow

6. Click OK.

7. To edit a domain, select the domain and click ’
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-

8. To delete a domain, select the domain and click u )

9. Click OK.

Credential Protection

Note - You must set the Zero Phishing and Password Reuse to Prevent or Detect to
set the Advanced Settings.

User can select any of these settings under Zero Phishing:

= Allow user to dismiss the phishing alert and access the website - It allows the user to
dismiss the blocking page and continue to enter the corporate password.

® Send log on each scanned site
= Allow user to abort phishing scans

® Scan local HTML files - By default, the Harmony Browse extension in Chromium-based
browsers (Chrome, Microsoft Edge, and Brave) cannot access the local HTML files
opened by the browser to scan them for phishing attacks. This setting prompts users to
grant permission to Chromium-based browsers to access and scan local HTML files on
your PC.

@ Notes:

» You can customize the prompt page. For more information, see "Configuring
Client Settings Policy" on page 50

» This feature is not supported with Safari and Internet Explorer browser
extensions.

To grant permission to access and scan the local HTML files:

1. When a user opens a local HTML file, the Harmony Browse request access to file
URLSs prompt appears. Click Click to copy.

2. Paste the copied path in the address bar of the Chrome browser and press Enter.
3. Scroll down and turn on Allow access to file URLs.

4. If the HTML file has an input field, Harmony Browse scans the file and blocks it, if
identified as phishing.

® Disable notifications - Allows you to disable the browser zero-phishing scan notification
that appears when users try to enter in an input field.

Note - Only the notification is disabled but the browser zero-phishing scan is
performed in the background indicated by the yellow highlight around the input
field.

User can select any of these settings under Password Reuse Protection:
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® To protect a domain, click Edit and enter the domain name or IP address.

® You can also select Allow users to dismiss the password reuse alert and access the
website setting.

Browser Settings
Pin Extension

This feature enables the administrator to configure to allow users to pin or unpin the browser
extension to the toolbar.

By default, Harmony Browse extension is pinned to the browser for all users with the Harmony
Browse Client version BROWSE_90.09.0001 and higher (Windows) and latest mac clients.

Note - You can unpin the extension only on Chromium browsers, such as Chrome,
Edge and Brave. You cannot unpin an extension in Firefox.

Windows

To allow users to unpin the browser extension, clear Always pin the browser extension to the
tool bar under Pin Extension.

The user must re-login by locking and unlocking the endpoint and either restart the browser or
wait for 15 minutes for the changes to reflect. This is not applicable to endpoints with the
Harmony Endpoint Security client installed as the browser extension is pinned automatically
through the policy update.

macOS

You cannot disable Extension Pinning through a policy in Harmony Browse.

To manually disable Extension Pinning:
1. Onthe endpoint, navigate to /Library/Application Support/Checkpoint/Threat Emulation/.

2. Remove these lines from the browser specific script. For example, for Chrome, the script
file name is install_chrome_ext.sh.

<key>SPIN KEY</key>
<string>$PIN VALUE</string>
3. Save and run the script.

4. Reload the policy on the browser. For example for Chrome, go to chrome://policy and
click Reload policies.

Control Browser Notifications

This feature allows administrators to control the following browser notifications:
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®= Disable Zero-Phishing notifications - Select the checkbox to disable the zero-phishing
scan notification that appears when users try to enter in an input field.

Note - Only the notification is disabled but the browser zero-phishing scan is
performed in the background indicated by the yellow highlight around the input
field.

® Disable Download Emulation & Extraction notifications - Select the checkbox to
disable the download emulation and extraction notifications whenever a file is
downloaded.

Incognito Mode

This feature allows administrators to control the availability of incognito mode for users. The
default option is Off.

Note - This feature is supported only for Endpoint Security client versions E88.60 and
higher.

® Off - The feature does not control the availability of incognito mode.
o Note - Users can access incognito mode depending on the organization policies.

® Enable - Forces incognito mode to be available for users, overriding any existing
settings that might restrict its availability.

® Disable - Prevents users from accessing incognito mode by disabling it completely.

Adding Exclusions to Rules

You can use either Legacy Exclusions and Smart Exclusions to add your exclusions. However,
we recommend that you use Smart Exclusions for the easy of managing exclusions.

Legacy Exclusions
You can exclude specific objects from inspection by the protections:

Adding Exclusions to a Specific Rule

To add exclusions to a specific rule:
1. Goto Policy > Threat Prevention > Policy Capabilities.
2. Select the rule for which you want to create the exclusion
3. Inthe Capabilities & Exclusions pane, click Exclusions Center.
4

. Expand an exclusion category. For example, Anti-Bot -> URL Filtering Exclusions.
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Note - Global Exclusions is read-only. To add Global Exclusions, see "Adding Global
Exclusions” below.
Expand Rule Exclusions.
Select the exclusions you want to add to the rule.
Click OK.

In the bottom right corner of the policy configuration pane, click Save.

© © N o O

From the top, click Install Policy.

Adding Global Exclusions

To add global exclusions that apply to all the rules:
1. Goto Policy > Threat Prevention > Global Exclusions.
2. Expand an exclusion category. For example, Anti-Bot -> URL Filtering Exclusions.
3. Select the exclusions you want to add to the rule.

4. Click Save.

5

. From the top, click Install Policy.

Adding Exclusions from Logs

To add exclusions from the Logs menu:
1. Goto Logs menu.

2. Right-click a log to add and configure an exclusion to your endpoint device. This
redirects you to the appropriate rule, section, and capability.

3. Select one of these options to apply the exclusions:
® Effective option: For a specific device or a user rule.

® All options: For a specific rule.

Adding a New Exclusion to an Exclusion Category

To add an exclusion to an exclusions category:
1. Do one of these:
® Go to Policy > Threat Prevention > Policy Capabilities.
® Go to Policy > Threat Prevention > Global Exclusions.

The Edit Exclusions Center window appears.
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2. Click ¥ .

The New Exclusion window appears.

3. Specify these details:

a.
b.

C.

Exclusion

Method

Value

(Optional) Comment

To add the exclusion to all the rules, select the Add to all rules checkbox. This step
does not apply to Global Exclusions.

Note - If the current rule contains this exception, then the system adds a duplicate
exclusion.

4. Click OK.

5. Inthe bottom right corner of the policy configuration pane, click Save.

6. From the top, click Install Policy.

Editing an Exclusion

To edit an exclusion:

1. Do one of these:

® Go to Policy > Threat Prevention > Policy Capabilities.

® Go to Policy > Threat Prevention > Global Exclusions.

The Edit Exclusions Center window opens.

2. Expand an exclusion category. For example, Anti-Bot -> URL Filtering Exclusions.

3. If you are editing a local exclusion, expand Local Exclusions. This step does not apply to
Global Exclusions.

4. Select the exclusion you want to edit.

5. Click 7

The Edit Exclusion window appears.

6. Specify these details:
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Exclusion

c o

Method

Value

o

d. (Optional) Comment

e. To apply the changes to all the rules that contain this exclusion, select the Update
all rules checkbox. This step does not apply to Global Exclusions.

f. To add the exclusion to all the rules that does not contain this exclusion, select the
Add to all rules checkbox. This step does not apply to Global Exclusions.

7. Click OK.
8. In the bottom right corner of the policy configuration pane, click Save.
9. From the top, click Install Policy.

Below is the list of supported exclusions.

URL Filtering Exclusions

You can exclude specific domains from a rule. Click + to add the required domain you want
to exclude from the rule.

Syntax
® *indicates a string or a character. For example, A* can be ADomain or AB or AAAA.

® ?indicates a character. For example, A? can be AA or AB or Ab.

For example:
If you enter It excludes these It does not exclude these
www.domain.com ® https://www.domain.com ® https://domain.com
B http://www.domain.com B http://domain.com
® https://sub.domain.com
® http://sub.domain.com
domain.com ® https://www.domain.com -
® http://www.domain.com
® https://domain.com
® http://domain.com
® https://sub.domain.com
B http://sub.domain.com
sub.domain.com ® https://sub.domain.com https://sub2.domain.com
® http://sub.domain.com
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If you enter It excludes these It does not exclude these
*.domain.com Sub-domain of domain.com
such as:

® https://sub1.domain.com

® http://sub2.domain.com

Threat Emulation, Threat Extraction, and Zero-Phishing Exclusions

You can exclude:

® Domains

® SHA1 hashes from Threat Emulation and Threat Extraction
Domain exclusions

® To exclude an IP, in the Element field, enter IP address followed by subnet mask in
the format <X.X.X.X>/ <subnet mask >. For example, to exclude a computer with IP
address 192.168.100.30, enter 192.168.100.30/24.

® Domain exclusions must be added without http, https or any other special characters
except asterisk (*).

Domain exclusions can be added with or without www.
® Sub-domain exclusions are supported.
Exclusion of a domain will exclude all its subdomains as well.

For example:

If you enter It excludes these It does not exclude these

www.domain.com ® https://www.domain.com
® http://www.domain.com

https://domain.com
http://domain.com
https://sub.domain.com
http://sub.domain.com

domain.com https://www.domain.com -
http://www.domain.com
https://domain.com
http://domain.com
https://sub.domain.com

http://sub.domain.com
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If you enter It excludes these It does not exclude these

sub.domain.com ® https://sub.domain.com https://sub2.domain.com
® http://sub.domain.com

*.domain.com Sub-domain of domain.com
such as:

® https://sub1.domain.com

® http://sub2.domain.com

SHA1 exclusions -
® |tis not supported with Internet Explorer.

® Macro exclusion - To exclude the office files which includes a macro, set exclusions
for the SHA1 hash of the macro.

For example, if an exclusion is set to SHA1 hash of the macro, all the files which
includes this macro are excluded.

o Notes -

» This is supported with Endpoint Security Client version E88.00 or
higher.

» To view the hash of a macro, see the Description in the Forensic
Details section in the Card of the event. For more information see,
Adding Exclusions from Logs.

Card »
Incident Details:

Description: To exclude the file: On the Harmony

Endpoint Management add this shal

exclusionldkdﬁs 37-6c70a%a-

I Th96286¢-162c7h75-58148a8d

® Excludes downloaded files from File Protection.

® Excludes local HTML files from Zero Phishing.

Smart Exclusions

Smart Exclusions allows you to add exclusions to one or more capabilities and types easily,
whereas the Legacy Exclusions allows you to add exclusion only for one capability at a time.

With Smart Exclusions, you can:
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Set exclusions to all capabilities and operating systems at once.
Use standard syntax across all exclusion types.
Use wider range of wildcard characters for nuanced and customized exclusion patterns.

Easily enable or disable exclusions with a simple toggle button without the need to delete
exclusions temporarily.

Adding Exclusions to a Specific Rule

CLICK HERE

TO START THE TUTORIAL

To add a new exclusion to a specific rule:

1.

2
3.
4

Go to Policy > Threat Prevention > Policy Capabilities.

. Select the rule for which you want to create the exclusion.

In the Capabilities & Exclusions pane, click Exclusions Center.

. Click Go to Smart Exclusions.

5. Click * or click Create New Exclusion.

To add an exclusion for only one exclusion type:

CHECK POINT
HARMONY BROWSE

You have no exclusion

¥ou can add manually or migrate from Legacy Exclusions

CREATE NEW EXCLUSION

4
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a. Click Single-method exclusion.

A wizard appears.

Web and Files Protection

NEW EXCLUSION x

OO
Anti Bot

Exclusion name

Domain
Apply to the following
e All supported

Domain

Select specific

Cancel

b. Inthe Exclusion name field, enter a name for exclusion.

c. To enable the exclusion, toggle Status to Enabled.

d. From the Exclusion Type list, select the exclusion type.
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e. From the Operating system list, select the operating system to which you want
to apply the exclusion. For example, endpoints running Windows operating
system only. It is not available if you select All supported in the Apply to the
following capabilities section.

Caution - If you make exclusions in the Forensics Monitoring
capability, the activities of the excluded processes are omitted from
forensic analysis. As a result, you cannot query for these activities in
Threat Hunting and they are excluded from Horizon XDR/XPR
analysis, detections, and the creation of security incidents related to
sophisticated attacks.

f. Inthe Apply to the following capabilities section:
® To apply the exclusion to all capabilities, select All supported.

® To apply the capabilities to specific capabilities, select Select specific and
from the Capabilities list, select the capabilities.

Notes:
® Capabilities not relevant to the selected group are not
available.
® For supported syntax and capabilities for exclusion types,
see sk181679.
If the !Exclusmn Then
Type is
File hash a. From the File hash type list, select the hash type:
= MD5
= SHA1
= SHA2

cdhash (for macOS only)
b. Inthe File hash value, enter the value.

IP Range In the IP Range fields, enter the IP address range.
For example, to enter IPv4 range, enter 192.168.1.30-
192.168.1.198.

For example, to enter IPv6 range, enter 2001::1-

2001::254.
Url In the URL field, enter the URL.
Domain In the Domain field, enter the domain. For example,

checkpoint.com.

g. (Optional) In the Comment field, enter comments.
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h. Click Save.
7. To add exclusions for multiple types of exclusions:

a. Click Multi-method exclusion.

A wizard appears.

NEW EXCLUSION x
OO
EXCLUSION PROPERTIES &
Ex on name
1/9 ME CTION
LS Status
@ Enabled
Exclusion group
Web Asset v
Operating el
All -
Apply to the following capabilities
® All supported Select specific
Comment

b. Inthe Exclusion name field, enter a name for exclusion.
c. To enable the exclusion, toggle Status to Enabled.
d. From the Exclusion Group list, select the exclusion type.

e. From the Operating system list, select the operating system to which you want
to apply the exclusion. For example, endpoints running Windows operating
system only. Itis not available if you select All supported in the Apply to the
following capabilities section.

Caution - If you make exclusions in the Forensics Monitoring
capability, the activities of the excluded processes are omitted from
forensic analysis. As a result, you cannot query for these activities in
Threat Hunting and they are excluded from Horizon XDR/XPR
analysis, detections, and the creation of security incidents related to
sophisticated attacks.
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f. In the Apply to the following capabilities section:
® To apply the exclusion to all capabilities, select All supported.

® To apply the capabilities to specific capabilities, select Select specific and
from the Capabilities list, select the capabilities. "Smart Exclusions” on
page 81

o Notes:

» Capabilities not relevant to the selected group are not
available.

» Anti-Exploit capability supports only Process path and
Infection/Protection exclusions.

g. (Optional) In the Comment field, enter comments.
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h. Click Next.

Note - For supported syntax and capabilities for exclusion types, see
sk181679.
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If the Exclusion
Group is

Exclusion Type

Web and Files Protection

Then

System

Process path

Process original
name

Process hash

Process signer !

a. Inthe Process path field, enter
the path of the process. For
example,
C:\windows\system\cmd.exe.

b. To specify additional criteria,
expand Process path options,
and select:

® Case sensitive

® Trusted process

® Argument and if required,
select Regex, and in the
Argument value field, enter
the value.

Enter the process original name. For
example, Cmd.exe.
Supported only for Windows-based
endpoints.
Notes -
® To find the original name of
the process:
i. Right-click on the
executable file.
ii. Go to Properties >
Details > Original
filename.
® Process original name is
case-sensitive.

a. From the Process hash type list,
select the hash type:
= MD5
= SHA1
= SHA2
cdhash (for macOS only)
b. Inthe Process hash value, enter
the value.

In the Process signer value field, enter
the process signer value. For example,
Check Point Ltd.
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If the Exclusion
Group is

Exclusion Type Then

File path a. Inthe File path field, enter the
path of the file. For example,
C:\windows\system\.

b. To specify additional criteria,
expand File path options, and
select Case sensitive.

File hash a. From the File hash type list,
select the hash type:
= MD5
= SHAT
= SHA2
cdhash (for macOS only)
b. Inthe File hash value, enter the
value.

File signer In the File signer value field, enter the
process signer value. For example,
Check Point Ltd.

Web Asset IP Range In the IP Range fields, enter the IP
address range.

For example, to enter IPv4 range,
enter 192.168.1.30-192.168.1.198.
For example, to enter IPv6 range,
enter 2001::1-2001::254.

Url In the URL field, enter the URL.

Domain In the Domain field, enter the domain.
For example, checkpoint.com.

i. Click Finish.

8. Click OK.
9. Click Save & Install.

Note - You can change Single-method exclusion to Multi-method exclusion.
See Managing Exclusions.
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Adding Global Exclusions

To add global exclusions that apply to all the rules:
1. Goto Policy > Threat Prevention > Global Exclusions.

2. Click Go to Smart Exclusions.

3. Click * or click Create New Exclusion.

4. To add an exclusion for only one exclusion type:

CHECK POINT
HARMONY BROWSE

[ capabities Value

LN @
You have no exclusion

=

= 1 us

L
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a. Click Single-method exclusion.

A wizard appears.

Web and Files Protection

NEW EXCLUSION x

OO
Anti Bot

Exclusion name

Domain
Apply to the following
e All supported

Domain

Select specific

Cancel

b. Inthe Exclusion name field, enter a name for exclusion.

c. To enable the exclusion, toggle Status to Enabled.

d. From the Exclusion Type list, select the exclusion type.
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e. From the Operating system list, select the operating system to which you want
to apply the exclusion. For example, endpoints running Windows operating
system only. It is not available if you select All supported in the Apply to the
following capabilities section.

Caution - If you make exclusions in the Forensics Monitoring
capability, the activities of the excluded processes are omitted from
forensic analysis. As a result, you cannot query for these activities in
Threat Hunting and they are excluded from Horizon XDR/XPR
analysis, detections, and the creation of security incidents related to
sophisticated attacks.

f. Inthe Apply to the following capabilities section:
® To apply the exclusion to all capabilities, select All supported.

® To apply the capabilities to specific capabilities, select Select specific and
from the Capabilities list, select the capabilities.

Notes:
® Capabilities not relevant to the selected group are not
available.
® For supported syntax and capabilities for exclusion types,
see sk181679.
If the !Exclusmn Then
Type is
File hash a. From the File hash type list, select the hash type:
= MD5
= SHA1
= SHA2

cdhash (for macOS only)
b. Inthe File hash value, enter the value.

IP Range In the IP Range fields, enter the IP address range.
For example, to enter IPv4 range, enter 192.168.1.30-
192.168.1.198.

For example, to enter IPv6 range, enter 2001::1-

2001::254.
Url In the URL field, enter the URL.
Domain In the Domain field, enter the domain. For example,

checkpoint.com.

g. (Optional) In the Comment field, enter comments.
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h. Click Save.
5. To add exclusions for multiple types of exclusions:

a. Click Multi-method exclusion.

A wizard appears.

NEW EXCLUSION x
OO
EXCLUSION PROPERTIES &
Ex on name
1/9 ME CTION
LS Status
@ Enabled
Exclusion group
Web Asset v
Operating el
All -
Apply to the following capabilities
® All supported Select specific
Comment

b. Inthe Exclusion name field, enter a name for exclusion.
c. To enable the exclusion, toggle Status to Enabled.
d. From the Exclusion Group list, select the exclusion type.

e. From the Operating system list, select the operating system to which you want
to apply the exclusion. For example, endpoints running Windows operating
system only. Itis not available if you select All supported in the Apply to the
following capabilities section.

Caution - If you make exclusions in the Forensics Monitoring
capability, the activities of the excluded processes are omitted from
forensic analysis. As a result, you cannot query for these activities in
Threat Hunting and they are excluded from Horizon XDR/XPR
analysis, detections, and the creation of security incidents related to
sophisticated attacks.
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f. In the Apply to the following capabilities section:
® To apply the exclusion to all capabilities, select All supported.

® To apply the capabilities to specific capabilities, select Select specific and
from the Capabilities list, select the capabilities. "Smart Exclusions” on
page 81

o Notes:

» Capabilities not relevant to the selected group are not
available.

» Anti-Exploit capability supports only Process path and
Infection/Protection exclusions.

g. (Optional) In the Comment field, enter comments.
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h. Click Next.

Note - For supported syntax and capabilities for exclusion types, see
sk181679.
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If the Exclusion
Group is

Exclusion Type

Web and Files Protection

Then

System

Process path

Process original
name

Process hash

Process signer !

a. Inthe Process path field, enter
the path of the process. For
example,
C:\windows\system\cmd.exe.

b. To specify additional criteria,
expand Process path options,
and select:

® Case sensitive

® Trusted process

® Argument and if required,
select Regex, and in the
Argument value field, enter
the value.

Enter the process original name. For
example, Cmd.exe.
Supported only for Windows-based
endpoints.
Notes -
® To find the original name of
the process:
i. Right-click on the
executable file.
ii. Go to Properties >
Details > Original
filename.
® Process original name is
case-sensitive.

a. From the Process hash type list,
select the hash type:
= MD5
= SHA1
= SHA2
cdhash (for macOS only)
b. Inthe Process hash value, enter
the value.

In the Process signer value field, enter
the process signer value. For example,
Check Point Ltd.
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If the Exclusion
Group is

Exclusion Type

Web and Files Protection

Then

Web Asset

File path

File hash

File signer

IP Range

Url

Domain

a. Inthe File path field, enter the
path of the file. For example,
C:\windows\system\.

b. To specify additional criteria,
expand File path options, and
select Case sensitive.

a. From the File hash type list,
select the hash type:
= MD5
= SHAT
= SHA2
cdhash (for macOS only)
b. Inthe File hash value, enter the
value.

In the File signer value field, enter the
process signer value. For example,
Check Point Ltd.

In the IP Range fields, enter the IP
address range.

For example, to enter IPv4 range,
enter 192.168.1.30-192.168.1.198.
For example, to enter IPv6 range,
enter 2001::1-2001::254.

In the URL field, enter the URL.

In the Domain field, enter the domain.
For example, checkpoint.com.

i. Click Finish.
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Migrating Legacy Exclusions

Best Practice - Check Point recommends to follow these steps before migrating to Smart
Exclusions:

Go to Policy > Threat Prevention > Policy Capabilities

Pick a rule to test the migration and clone the rule.

Place the newly created rule at the top.

Under Applied To, select a test group.

Click Exclusion Center for the newly created rule and export the legacy exclusions
for backup purposes.

6. Forthe newly created rule, migrate to Smart Exclusions. See "To migrate legacy
exclusions to smart exclusions:" below.

7. Click Save and Install.

8. Go to Logs and filter the logs for the computer in the test group. Verify that there are
no false positives and all the detections are excluded correctly. If there are issues,
contact Check Point Support.

9. Perform the steps 1 through 8 for each rule at a time.

10. Repeat the process for Global Exclusions.

oL =

To migrate legacy exclusions to smart exclusions:
1. To migrate legacy exclusions for a rule:
a. Goto Policy > Threat Prevention > Policy Capabilities.
b. Select the rule.
c. Inthe Capabilities & Exclusions pane, click Exclusions Center.

2. To migrate legacy global exclusions, go to Policy > Threat Prevention > Global
Exclusions.

3. Click Go to Smart Exclusions.
4. To migrate all legacy exclusions:
a. Click Migrate from Legacy Exclusions (available only if there are no exclusions) or
click = and click All exclusions from legacy.
The Import All Legacy Exclusions window appears.

b. (Recommended) To remove all the legacy exclusions after you migrate to smart
exclusions, select Remove all the imported exclusions from legacy.

c. Click Import.

5. To migrate specific exclusions:
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a. Click = and Select exclusions from legacy.
The Transfer from Legacy - Select Exclusions window appears.
b. Select the exclusions.
c. Click OK.
The exclusions are added to smart exclusions.
6. For specific rule, click OK and Save & Install.
7. For global exclusions, click Save.

The exclusions are automatically enforced on the client without installing the policy.

Importing and Exporting Exclusions

To import or export exclusions:
1. Toimport or export exclusions for a rule:
a. Goto Policy > Threat Prevention > Policy Capabilities.
b. Select the rule.
c. Inthe Capabilities & Exclusions pane, click Exclusions Center.

2. Toimport or export global exclusions, go to Policy > Threat Prevention > Global
EXxclusions.

3. Click Go To Smart Exclusions.

4. Toimport exclusions:

a. Click = and click Import Files.

b. Browse and select the import file in the JSON format.
c. For specific rule, click OK and Save & Install.

d. For global exclusions, click Save.

The exclusions are automatically enforced on the client without installing the policy.

5. To export exclusions, click

The file is exported in the JSON format.
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Managing Exclusions

To manage exclusions:
1. To manage smart exclusions for a rule:
a. GotoPolicy > Threat Prevention > Policy Capabilities.
b. Select the rule.
c. Inthe Capabilities & Exclusions pane, click Exclusions Center.

2. To manage global smart exclusions, go to Policy > Threat Prevention > Global
Exclusions.

3. Click Go To Smart Exclusions.

4. To edit an exclusion:

" Select the exclusion and click Z .
® Right-click the row and click Edit.

To a change Single-method exclusion to Multi-method exclusion, click Edit in
multi-value wizard at the bottom of the wizard.

Refer to "Adding Exclusions to a Specific Rule" on page 82 to edit the exclusion.

5. To delete exclusions:
® Select the exclusions and click ™ .

® Click the row and at the end of the row, click L .
® Select the exclusions, right-click and click Delete.

6. To duplicate exclusions:
. . Iy
" Select the exclusion and click ™ .

. . [§
" Click the row and at the end of the row, click .
® Select the exclusion, right-click and click Duplicate.
7. To enable or disable the exclusion, toggle the button in the Status column.

8. To edit Name, Capabilities and Comment:
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a. Click the row.

b. Atthe end of the row, click * .
c. Editthe details.
d. Click v.
9. For a specific rule, click OK and Save & Install.
10. For global exclusions, click Save.

The exclusions are automatically enforced on the client without installing the policy.

Browser Settings

Disabling Incognito Mode, BrowserGuest Mode, and InPrivate Mode
Overview

The browser extension is not installed automatically if the Incognito, Guest or InPrivate mode
is enabled in your browser. We recommend that you disable these modes to secure your
users.

Chrome on Windows

To disable Incognito mode and BrowserGuest mode:
1. Select Start and type CMD.
2. Right-click Command Prompt and select Run as administrator.

The Command Prompt window appears.

S8 1o disable Run

Incognito mode REG ADD HKLM\SOFTWARE\Policies\Google\Chrome /v
IncognitoModeAvailability /t REG DWORD /d 1

BrowserGuest REG ADD HKLM\SOFTWARE\Policies\Google\Chrome /v
mode BrowserGuestModeEnabled /t REG DWORD /d O

Firefox on Windows

To disable InPrivate mode:
1. Select Start and type CMD.

2. Right-click Command Prompt and select Run as administrator.
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The Command Prompt window appears

S Todisable Run
InPrivate REG ADD HKLM\SOFTWARE\Policies\Mozilla\Firefox /v
mode DisablePrivateBrowsing /t REG DWORD /d 1

Microsoft Edge on Windows

To disable BrowserGuest mode and InPrivate mode:
1. Select Start and type CMD.
2. Right-click Command Prompt and select Run as administrator.

The Command Prompt window appears

S8 1o disable Run

BrowserGuest REG ADD HKLM\SOFTWARE\Policies\Microsoft\Edge /v
mode BrowserGuestModeEnabled /t REG _DWORD /d O

InPrivate mode REG ADD HKLM\SOFTWARE\Policies\Microsoft\Edge /v
InPrivateModeAvailability /t REG DWORD /d 1

Brave on Windows

To disable Incognito mode, Incognito mode with Tor and BrowserGuest mode:
1. Select Start and type CMD.
2. Right-click Command Prompt and select Run as administrator.

The Command Prompt window appears

S8 1o disable Run

Incognito mode REG ADD
HKLM\SOFTWARE\Policies\BraveSoftware\Brave /v
IncognitoModeAvailability /t REG DWORD /d 1

BrowserGuest REG ADD
mode HKLM\SOFTWARE\Policies\BraveSoftware\Brave /v

BrowserGuestModeEnabled /t REG _DWORD /d 0
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To disable

Incognito mode REG ADD
with Tor HKLM\SOFTWARE\Policies\BraveSoftware\Brave /v

TorDisabled /t REG DWORD /d 1

Chrome on macOS

To disable incognito mode and BrowserGuest mode:
1. Inthe Finder, click Go > Utilities.
2. Openthe Terminal app.

The Terminal app window appears.

S To disable Run

Incognito mode defaults write com.google.chrome
IncognitoModeAvailability -integer 1z

BrowserGuest defaults write com.google.Chrome
mode BrowserGuestModeEnabled -bool false

Firefox on macOS

To disable InPrivate mode:
1. Inthe Finder, click Go > Utilities.

2. Openthe Terminal app.

The Terminal app window appears.

S Todisable Run
InPrivate defaults write
mode /Library/Preferences/org.mozilla.firefox

DisablePrivateBrowsing -bool TRUE

Microsoft Edge on macOS

To disable BrowserGuest mode and InPrivate mode:
1. Inthe Finder, click Go > Utilities.

2. Openthe Terminal app.
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The Terminal app window appears.

To disable Run
BrowserGuest defaults write com.microsoft.edge
mode BrowserGuestModeEnabled -integer 0

InPrivate mode defaults write com.microsoft.edge
InPrivateModeAvailability -integer 1

Enabling the Browser Extension on a Browser with Incognito or
InPrivate Mode

You can enable Harmony Browse extension on your browser in Incognito or InPrivate mode.

To enable the Harmony Browse extension on Chrome in the Incognito mode:

1. In your browser's address bar, type chrome://extensions/ and locate the Harmony
Browse extension.
2. Click Details and enable Allow in Incognito.

To enable the Harmony Browse extension on Edge in the InPrivate mode:

1. In your browser's address bar, type Edge://extensions/ and locate Harmony
Browse extension.
2. Click Details and select Allow in Private checkbox.

To enable the Harmony Browse extension on Firefox in the InPrivate mode:

1. Inyour browser's address bar, type about :addons and select Extensions.
2. Click the Harmony Browse Extension.
3. In Run in Private Windows, select Allow.

Ending the Browser Process Running in the Background

When you close Chrome and Edge browsers with the Harmony Browse extension installed,
the browser process continues to run in the background. You can perform these procedures to
end the browser process running in the background.

To end the Chrome browser process running in the background:
1. Select Start and type CMD.
2. Right-click Command Prompt and select Run as administrator.

The Command Prompt window appears.

3. Run:
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REG ADD HKLM\SOFTWARE\Policies\Google\Chrome /v
BackgroundModeEnabled /t REG DWORD /d O

4. Press Enter.

To end the Edge browser process running in the background:
1. Select Start and type CMD.
2. Right-click Command Prompt and select Run as administrator.
The Command Prompt window appears.

3. Run:

REG ADD HKLM\SOFTWARE\Policies\Microsoft\Edge /v
BackgroundModeEnabled /t REG DWORD /d O

4. Press Enter.

Browser Extension Pinning

For more information, see Browser Settings in "Web and Files Protection" on page 57 .

Managing loCs

Indicator of Compromise (IoC) is an indicator to cyber security professionals about an unusual
activity or an attack. Harmony Browse allows you to add |oCs for domains, |IP addresses,
URLs, MD5 Hash keys and SHA1 Hash keys that are automatically blocked by File Protection
(Threat Emulation and Threat Extraction) and URL Filtering without the need to install the

policy.
Prerequisite

® Forthe loCs domain, IP address and URL, activate (Prevent or Detect) the URL Filtering
capability.

® Forthe loCs MD5 Hash and SHA1 Hash, activate (Prevent or Detect) the Download
Protection capability.

To add loCs:
1. Click Policy > Threat Prevention.

2. Click Manage loCs.

3. Click ¥ .

The New loC window appears.
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4. Select a Type and enter a Value and Comment (optional).

5.

Click OK.
The loC is added to the table.

To import loCs from an excel sheet:

You can import loCs from an excel sheet containing up to 10000 entries in the format:

B15 = i
A B
1 |Domain checkpoint.com
2 |IP 192.168.1.1
3 |URL http://checkpoint.com/test.htm
4 'MD5 2eh040283b008eecel7aa2988ecel13152
5 SHA1 5¢528ebc85c¢151361dc02ed08a25eh25f665fd 8f
6 |Domain test.com
7 |IP 192.168.1.2
8 |URL http://mytest.com/test.htm
9 [MD5 2eb040283b008eece17aa2988ecel13153

10

SHA1 5¢528ebc85¢151361dc02ed08a25eb25f665fd8k

. Click Policy > Threat Prevention.

Click Manage loCs.

Click = .

The Import loCs window appears.

. Click Upload and select the excel sheet.

Note - The system verifies the entries in the excel and discards invalid entries.

Click Import.
The loCs are added to the table.

To edit an 10C:

1.
2.

Click Policy > Threat Prevention.
Click Manage loCs.
Select the loC.

. Click

C
This is your comment
This is your comment
This is your comment
This is your comment
This is your comment
This is your comment
This is your comment
This is your comment
This is your comment
This is your comment
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5.
6.

The Edit loC window appears.
Make the required changes.

Click OK.

To delete loCs:

1.
2.
3.

Click Policy > Threat Prevention.

Click Manage loCs.

Select the loCs.

. Click ¥ .

A prompt appears.

Click OK.

To export loCs to an excel sheet:

1.
2.

3.

Data Loss Prevention

Click Policy > Threat Prevention.

Click Manage loCs.

Click ©

The system exports the 0Cs to an excel sheet.

Web and Files Protection

Data Loss Prevention (DLP) detects and prevents unauthorized transmission of confidential
information, such as social security numbers, credit card numbers, bank account numbers and
so on.

Browser-Based DLP capabilities allow you to enforce DLP by associating data types with a
DLP rule.

In the Data Loss Prevention tab, you can set rules based on specific events, data types and
actions.

These actions are available within the DLP rules:

® Detect - Performs the DLP scan but does not block the data.

® Prevent - Performs the DLP scan and prevents data transfer if it finds a match to a data

type.

® Allow - Acts as exclusions, allowing data transfer in certain events.
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® Block - Blocks the data without the DLP scan.

® Ask - Asks the user to provide justification before allowing data transfer based on the
DLP scan results.

The Data Loss Prevention tab allows the administrator to enable and install the Gen Al Protect
feature on the endpoints. Gen Al Protect monitors the use of various Gen Al tools by the
endpoints. It detects and prevents the sharing of potential confidential information in the
prompts to any Gen Al tools by the Endpoint Security Clients.
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o Notes:

® You can find the policy version number in the bottom left corner of the page.

& comy oo @ 0LP0: S E— o

9

® You can find both policy name and policy version number in the browser
extension.
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w (@ O

. .
q, Harmony Browse View Demo > eloper

TP Policy: E2E Automation 1 - DONT CHANGE POLICY (Threat Emulati...
' TP Version: 192

DLP Policy: Amit (Data Loss Prevention)

DLP Version: 20

Clear completed Collect logs Hide policy info

DLP Logs

®  |ogs are sent for Block, Prevent, Detect, and Ask actions.

® File upload and File download events generate log for each handled file, regardless of
whether the event is blocked, prevented, detected, or allowed.

= Text control, Copy and Paste events send logs for blocked, prevented, or detected
incidents.
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Use Case

You are a financial organization aiming to prevent the upload or download of files containing
confidential and sensitive data, such as bank account numbers, tax and revenue details, by
unauthorized users.

Known Limitations
® This feature is supported in EU and US regions only.
® DLPis not applied if the file size is greater than 10 MB.

® DLPis not applied when you drag and drop a folder to upload files, and in such cases,
the upload of the folder gets blocked.

® |f the downloaded file is scanned by DLP, it is not sent to Threat Emulation.

Sample Data Type

For supported data and file types, see sk181662.

€ DLP Data Type Manager i Discard [ Save < Lest update 17 Jan 2024 2:09 PM
# New » Geography: Seloct. Regulation: Selacr. + @ Q @ 150items  Cr
_
~ Predefined Daca Types WP Canada Passport Number o # Addwgroup v [l Duplicare 7 Edit
o o ®
e @
::* ‘hreshol e
- 9.
Legends Description
1 Name of the data type.
2 Date and time (in MM/DD/YY, HH:MM:SS XM format) when the data type
was last modified.
3 Brief description of the data type.
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Legends Description

4

5

10

11

12

13

14

Custom tags (category) for the data type. Helps in searching for data types.

Matching criteria:

Pattern

Keyword

Dictionary

Weighted Words

Template

File attribute

Compound (Combination of data types with a logical separator)
Group (Data type group)

The minimum number of times the matching criteria must be present in the
file to trigger the DLP action specified in the policy capability rule. For
example, if the matching criteria is Keyword, the value is credit and the
Matching Threshold is 5, then the system takes the action specified by the
policy capability rule if the file contains the term credit five times or more.

Policy capability rules where the data type is used.
Groups associated with the data type.

Add the data type to a group.

Duplicate the data type.

Edit the data type.

Comment.
Filter data type by category.

Search for a data type.
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Creating a Custom Data Type

To create a custom data type:

1.

Go to Policy > Data Loss Prevention and click DLP Data Type Manager.

e; CHECK POINT

Harmony Endpoint

. 0| [iReednigos 9

Inbound events.

PolicyType: | @ Comnected  + (ECore+ & Copy  Delere

Rule Name Applied To

Global Exclusions

+ Data Protection Testing |

General

OneCheck

Endpoint Client

Browse
Outbound events  Inbound events

Export/import Policies

@ Disablea
[ s e === == =
« Paste Arificial Inteligence (A) PCI-Card Security Code. P Address @ Freen
« File upload webwhatsapp.com 1P Address ® Frevens
© File upload mail google.com N/A © Block
o) File upload nai.com bing.com @ Prevent
«© File upload laude.aiflogin urity Code @ Prevent
« File upload uriey Code Detect
« Text conrl Arificial Intelige PCI- Card Security Code. P Address ® Freen
2. Click New and select Data type.
€ DLP Data Type Manager # Discard B Save © Lastupdate 17
# New + Geography: Select Regulation: Select. + Q Oitems O
WD Datztype
& Group —
QP EU Data Protection Directive @ Duplicate 7/ Edit

pes
* Custom Data Types
» My Groups

* Check Point Recommended

WP EU Data Protection Directive

eFile

el Dota Records Match fied as per-

- 95/46/EC), a directive which regulates the processing of personal data within
the European Union; indicates

al information according to the European Union (EU) Data Protection Direct
s of persanal information.

Health Information

unt Number - IBAN

Regulation: GDPR Geography: EU Personal Informatian

sonally Identifisble Information

The Add data type wizard appears.
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Add comment

Data type recognition method

[#] pattern

Web and Files Protection

Fatiern
Keyword . §
! Diefine & regulsr exprezzion that will be
Dictionary matched sgsinst content in dsta
Weighted Wards transmissions. Transmissions that contain
strings that match the pattern in their dats
Templste

are matched.
File attribute

3. Enter the data type name, object comment (optional) and description.

4. From the Data type recognition method list, select a recognition method:

Recognition method

Description

Pattern

Applies the action specified
in the policy capability rule if
the file contents match the
threshold for the pattern. For
example, 5523-2342.

Applies the action specified
in the policy capability rule if
the file contents match the
threshold for the keyword.
For example, Confidential,
Secret.

In the Patterns section,

enter the pattern and click
+.

In the Keywords section,
enter the keywords and
click +.
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Recognition method Description Action

Dictionary Applies the action specified Upload the dictionary file.
=< | in the policy capability rule if
the file contents match the
threshold for the terms in the
dictionary. For example,
Spain, China, United
Kingdom.

Each keyword must be
specified in a single line in
the UTF-8 format.

o Note - The
recommended file
formats are Microsoft
Word and .txt.
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Weighted Words

wegre

e

Applies the action specified
in the policy capability rule if
the file contains keywords
and the cumulative weight
matches or exceeds the
threshold.

Use this method to specify
multiple keywords.

For example, consider two
keywords:
® credit with Weight=1
and Max. Weight=3
® transaction with
Weight=2 and Max.
Weight=30
and Matching
Threshold=15.

If the file contains six
occurrences of credit, each
contributing a Weight of 1.
Thatis, 1x6=6. As the Max.
Weight=3, the final weight is
3.

If the file contains eight
occurrences of transaction,
each contributing a Weight of
2. Thatis, 2x8=16. As the
Max. Weight=30, the final
weight is 16.

As the sum of final weights of
credit and transaction, that
is, 16+3=19 is greater than
the Matching Threshold, the
system applies the specified
action in the policy capability
rule.

a. Click New.

b. Enterthese:

= Keyword

= Weight -
Weight for
each
occurrence of
the keyword.

® Max. Weight -
Maximum
allowed for
weight for the
keyword.

c. Ifthe keywordis a
regular expression,
turn on the Regex
toggle button.

d. Click Add.

e. Repeat steps a
through dto add the
next keyword.
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Template

File attribute

If the sum of the final weights
of the keywords is less than
the Matching Threshold,
then the file is uploaded or
downloaded.

Applies the action specified
in the policy capability rule if
the file contents match the
threshold for the terms in the
template. For example, a
template with a set header,
footer and logo.

If the template contains
images, the DLP is triggered
only if the file contains the
images in the same format as
in the specified template.

Applies the action specified
in the policy capability rule if
the file:
® Matches the specified
file name.
® Sizeis equal toor
greater than the
specified file size.
® Type matches the
specified file type.

Upload the template file.

Select any of these and
enter a value:
® File name. For
example, Account
Numbers, Employee
Details.
® File size. File size in
Byte, KB, MB or GB.
® File type.

* Click * and
select the file
type(s) from
the list.

5. Click Next.

Note - This step does not apply to Template and File attribute recognition

methods.

6. Select the matching threshold.

The minimum number of times the matching criteria must be present in the file to trigger
the DLP. For example, if the matching criteria is Keyword, the value is credit and the
Matching Threshold is 5, then the system takes the action specified by the policy
capability rule if the file contain the term credit five times or more.
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Add data type (G

o GENERAL Matching Threshold

o MATCHING CRITERIA

e MATCHING THRESHOLD

Thizs data will be matched only if it the number of occurrences is at least :

Note - This step does not apply to Template and File attribute recognition
methods.

7. Click Finish.
The new custom data type is listed under Custom Data Types.
8. To permanently save all the changes to the database, click Save at the top.

The change detected window appears.

There is 1 change detected X

Saving the objects will store the updated information in the
database permanently. Are you sure you want to proceed with
saving all changes?

CAMNCEL COMFIREM

9. Click Confirm.
10. Todiscard all the changes, click Discard at the top.

The change detected window appears.
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There is 1 change detected

Discarding the objects will delete any unsaved changes. Are you
sure you want to proceed with discarding all changes?

CANCEL CONFIRM

11. Click Confirm.

Creating a Custom Data Type Group

To create a custom data type group:

1. Goto Policy > Data Loss Prevention and click DLP Data Type Manager.

® CHECKPOINT
v " Infi Al Copilot
& Harmony Endpoint @ iy A Copi

EEEEEEE - e e | sercririeay. 0| |SARAIONE 2

afRAAAn

2. Click New and select Group.
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2
€ DLP Data Type Manager i Discard [B Save Lastupdats 17 Jan 2024 2:20 PM

# New ~ Geography: Select. Regulation: Select + Q 10iems O

WD Datztype

W Group
= QP EU Data Protection Directive [ Duplicate # Edit
» Custom Data Types

Regulation: GDPR Geography: EU Personal Informarian

The New Data type Group window appears.

New Data type Group X

1 Add group name*
",

Add object comment

Create a complex data type representation. A group data type includes multiple Data
Types that are matched.

Genera

Predefined Data types

+

Custom Data types

+

Enter a group name, object comment (optional) and description.

To add predefined data types to the group, click * in the Predefined Data types field
and select the data type.

To add custom data types to the group, click * in the Custom Data types field and
select the data type.

Click Save.

The new data type group is listed under My Groups.
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7. To permanently save all the changes to the database, click Save at the top.

The change detected window appears.

There is 1 change detected x

Saving the objects will store the updated information in the
database permanently. Are you sure you want to proceed with
saving all changes?

CAMNCEL COMFIREM

8. Click Confirm.
9. To discard all the changes, click Discard at the top.

The change detected window appears.

There is 1 change detected x

Discarding the objects will delete any unsaved changes. Are you
sure you want to proceed with discarding all changes?

CANCEL CONFIRM

10. Click Confirm.
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Adding an Existing Data Type to a Group

To add an existing data type to a group:

1. Go to Policy > Data Loss Prevention and click DLP Data Type Manager.

] @ CHECKPOINT
@ Harmony Endpoint

o Usmedras 0 - 9

2. Inthe Data Type Name list, expand Custom Data Types or Predefined Data Types and

select the data type.

# New ~ Geography: Select. Regulation: Select.

A

» Predefined Data Types
~ Custom Data Types
NG Age

¥, EU Data Protection Directive- Duplicated demo

&

Group Test1

Testl

-}

Test Group3

W, GROUP4

W, Group Test1- Duplicated

88

Testingd

K3

Test

& 8

GROUP 4 - Duplicated

W, Group Test1- Duplicated

Test1 - Duplicated

g8

)
[ ]
)
» My Groups

+ Check Point Recommended

3. Click Add to group.

4. Select the group(s) from the list.

5. Click Add.

Q 19items Q¥

[ T/] # Addtogroup ~  [J§ Duplicate 7 e W Del

test

ptio
Tag!
Data type not associated to any tag yet
Type
[ Pattern
atching Thrashold
yet

Group Test1, Test Group3, GROUP 4, Group Test1- Duplicated . GROUP 4 - Duplicated, Group Test1 - Duplicated
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6. To permanently save all the changes to the database, click Save at the top.

The change detected window appears.

There is 1 change detected x

Saving the objects will store the updated information in the
database permanently. Are you sure you want to proceed with
saving all changes?

CAMNCEL COMFIREM

7. Click Confirm.
8. To discard all the changes, click Discard at the top.

The change detected window appears.

There is 1 change detected x

Discarding the objects will delete any unsaved changes. Are you
sure you want to proceed with discarding all changes?

CANCEL CONFIRM

9. Click Confirm.

Editing a Data Type or Group

Note - If you edit a data type, the changes are reflected in all the groups that contain
this data type.
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To edit a data type or group:
1. Goto Policy > Data Loss Prevention and click DLP Data Type Manager.

e; CHECK POINT

Harmony Endpoint

PoieyType: | @ Comnecred Eone- | & copy B Deiece

ot 0| (GRS 9

Inbound events.

Rule Name Applied To

Global Exclusions

+ Data Protection Testing.

General

Data

S —
=
n

Client Seczings

+ Deployment Policy

* Export Package
Endpoint Client

Browse

Outhound events  Inbound events

Export/import Policies

@ Dissbleal
n Status Evenc [r— [— Acion

« Pase Archical Ineligence (4) PC1- Card Security Code P hddress ® Freen
« Fle uplosd webuhatsapp.com 1P Address ® Freen
o) File upload mail google.com N/A © Block

© Fle uplosd chatopensicon  bingeom 1 More 1P Address ® Prevent
«© File upload laude.aiflogin PCI - Card Security Code @ Prevent
« Fle upiasd PCI- Card Security Code Detect
« Textconrol PC1- Card Security Code P address ® Freen

2. Inthe Data Type Name list, expand the DLP group and select the data type or the group.

Regulatio

+ Q 1gitems O

V. .

+ Predefined Data Types [ 7] et 4 Addtogoup ~ [ Duplicste  / Edit  f Delete

~ Custom Data Types

Age

g

EU Data Protection Directive- Duplicated demo

&

Group Test1

ption

) &

Test1 Testing

-
=

o

Test Group3
Tags

u

GROUP 4

Data type not associated to any tag yet

o

Group Test1- Duplicated

Type

Testingd [ pattern

(-

o

8

Test Matching Threshold

&

GROUP 4 - Duplicated 2

o

Group Test1 - Duplicated

Test1 - Duplicated

ciated yet

&8

o

-

Group Test1, Test Group3, GROUP 4, Group Test1- Duplicated . GROUP 4 - Duplicated, Group Test1 - Duplicated

K3

» My Groups

* Check Point Recommended

3. Click Edit.
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- Test1
4 test

heck Poin: Recommended

4. Make the required changes.

o Note - In the Check Point Recommended and Predefined Data Types DLP
groups, you can edit only Matching level and Add object comment.

5. Click OK.
6. To permanently save all the changes to the database, click Save at the top.

The change detected window appears.
There is 1 change detected X
Saving the objects will store the updated information in the

database permanently. Are you sure you want to proceed with
saving all changes?

CAMNCEL COMFIREM

7. Click Confirm.
8. To discard all the changes, click Discard at the top.

The change detected window appears.
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There is 1 change detected

Discarding the objects will delete any unsaved changes. Are you
sure you want to proceed with discarding all changes?

CANCEL CONFIRM

9. Click Confirm.

Duplicating a Data Type or a Group

To duplicate a data type or group:
1. Goto Policy > Data Loss Prevention and click DLP Data Type Manager.

® CHECKPOINT
v " Infi Al Copilot
& Harmony Endpoint @ iy A Copi

EEEEEEE - e e | sercririeay. 0| |SARAIONE 2

afRAAAn

2. Inthe Data Type Name list, expand the DLP group and select the data type or the group
within.
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# New - Geography: Select.. Regulation: Select.. + Q 2sitems O
- Predefined Dats Types P Age # Addtogroup v I Duplicate 7 Edit

WP ABA Transit Numbers
W@ AD or LDAP Attributes and Classes

WP AD or LDAP Distinguished Names

WP ASIC or FPGA Designs

NP Active Directory or LDAP Entries Descriptio
_ A age. The match is based on regex, and the threshold is 10
N Africa IBAN .
"20 years 11 months”

e
W ie *10 months’
W@ Airline Ticket Identification Number
W Albania Classification Terms Tags
WP Albania IBAN Regulation: GDPR Geography: Global Personal Information
WB American Express Travelers Cheques Number
W Americas BAN Type
WP Andorra IBAN [ pattern
W@ Anguilla Phone Numbers
WP Antigua and Barbuda Phone Numbers Matching Threshold
WP Archive File o
W Argentina Classification Terms

WP Argentina DNI Number

W@ Asia IBAN
» Custom Data Types
» My Groups
Group Test1, GROUP 4, Group Test!- Duplicated, GROUF 4 - Duplicated, group group
» Check Point Recommended

Click Duplicate.
Make the required changes.

Click OK.

o g &~ »w

To permanently save all the changes to the database, click Save at the top.

The change detected window appears.

There is 1 change detected

Saving the objects will store the updated information in the
database permanently. Are you sure you want to proceed with
saving all changes?

CAMNCEL COMFIRM

7. Click Confirm.
8. To discard all the changes, click Discard at the top.

The change detected window appears.
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There is 1 change detected

Discarding the objects will delete any unsaved changes. Are you
sure you want to proceed with discarding all changes?

CANCEL CONFIRM

9. Click Confirm.

Deleting a Data Type or a Group

Note - Before you delete a data type, make sure to remove the data type from the
group(s) and policy capability rules.

To delete a data type or group:

1. Goto Policy > Data Loss Prevention and click DLP Data Type Manager.

® CHECKPOINT
v " Infi Al Copilot
& Harmony Endpoint @ iy A Copi

D Ursmedies 0 - 2

2. Inthe Data Type Name list, expand the DLP group and select the data type or the group
within.
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# New ~ Geography: Select.. Regulation: select.. +

Data Type Name

» Predefined Data Types
~ Custom Data Types

Age

@, EU Data Protection Directive- Duplicated demo
W Group Test1

NG Test!

) TestGroup3

W GROUP4

W, Group Test1- Duplicated
WO Testing4

NG Test

1@, GROUP 4- Duplicated

&

Group Test1 - Duplicated

Test! - Duplicated

28

rat
&

{
i &

=
* My Groups

* Check Point Recommended

Click Delete.

F . Testl
L [

test

Date modified

11/17/2023, 2:11:44 PM

Description

Testing

Tags

Data type not associated to any tag yet

Type

[ Pattern

No rules associated yet

Group Test1, Test Group3, GROUP 4, Group Test1- Duplicated

The Deleting a data type window appears.

Deleting a data type x

o You are about to delete "™

MNote this cannot be undone.

Click Delete Data Type.

CANCEL DELETE DATA TYPE

Web and Files Protection

Q 10items ¥

# Add to group v [@ Duplicate / Edit W Delete

. GROUP 4 - Duplicated, Group Test1 - Duplicated

To permanently save all the changes to the database, click Save at the top.

The change detected window appears.

There is 1 change detected

Saving the objects will store the updated information in the
database permanently. Are you sure you want to proceed with

saving all changes?

Click Confirm.

CAMNCEL COMFIRM

To discard all the changes, click Discard at the top.
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The change detected window appears.

There is 1 change detected x

Discarding the objects will delete any unsaved changes. Are you
sure you want to proceed with discarding all changes?

CANCEL CONFRM

8. Click Confirm.

Managing Microsoft Sensitivity Labels for DLP

Harmony Browse allows you to integrate Sensitivity labels from Microsoft Purview Information
Protection into your DLP system, providing an additional layer of data protection based on
predefined sensitivity classifications.

Step 1 - Copy the Microsoft Sensitivity label names and their UUIDs
from Microsoft Purview

Finding the UUID of labels in the Old Microsoft Purview portal

1. Log in to Microsoft Purview Portal: https://purview.microsoft.com/

2. Go to Solutions > Information protection > Labels.

£ C % compliance.microsoft.com/finformationprotection/labels?tid=

Confidential

3. Click the label name for which you want to find the UUID.
4. Copy the UUID in the Label ID or GUID section.
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Finding the UUID of labels in the New Microsoft Purview portal

1. Install the Exchange Online Management Module

The Microsoft Purview Security & Compliance PowerShell uses the Exchange Online
Management Module for connection.

a. Open PowerShell as an administrator.
b. Run the following command:
Install-Module -Name ExchangeOnlineManagement -Force

c. Ifthe system prompts to install NuGet or trust the repository, enter Y and press
Enter.

2. Connect to the Microsoft Purview Security & Compliance Center.
a. Run the following command to create a session:
Connect-IPPSSession

b. Inthe Microsoft login page that appears, authenticate with the Microsoft 365
administrator credentials.

Note - The administrator must have Compliance Administrator or
Information Protection Administrator roles.

c. If your Microsoft Purview portal has Multi-Factor Authentication (MFA), complete
the MFA process.

Once authenticated, the session connects to the Microsoft Purview Security &
Compliance Center.

Now, you can run Microsoft Purview Security & Compliance PowerShell commands,
such as managing labels, policies, or settings.

3. Toview the UUID of the labels, run the following commands:

Get-Label | Select-Object DisplayName, Name, Guid

4. Copy the UUID of the labels.
5. Todisconnect the session, run the following command:

Disconnect-ExchangeOnline
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Step 2 - Creating Microsoft Sensitivity Labels in Harmony Browse
1. Log in to Infinity Portal and access the Harmony Browse Administrator Portal:
2. Goto Policy > Data Loss Prevention and click DLP Data Type Manager.

3. Click Manage Labels.

@ CHECK POINT

[ —

-
B
2
®
o
S
R
5
H

< DLP Data Type Manager

v Threat Prevention

Policy Capabilities

U]
Foucy + Q 4items <
. WO CP Confidential # Addtogroup v 4 Edit i Delete &
g » Custom Data Types =
T
- Access Rules » My Groups £

Data Loss Prevention * sensitivity Labels 312024, 8:24:02 PM

* Check Point Recommended
Access & Compliance

Client Settings Description
Microsoft Sensitivity Label
+ Deployment Policy

&

THREAT.

Data type not associated to any tag yet

Endpoint Client pe
® Label

Browse Client

Export/import Policies

The Manage Sensitivity Labels Dashboard window appears.
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Manage Sensitivity Labels Dashboard X

Labels configuration

Define a list of Microsoft Sensitivity label names and their corresponding UUIDs. The
labels will be represented as data types in the system.

#* New s Edit B Delete Q Search.

Name Ui

4 items

4. Click New.
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Manage Sensitivity Labels Dashboard X

Labels configuration

Define a list of Microsoft Sensitivity label names and their corresponding UUIDs. The
labels will be represented as data types in the system.

#* New /s E § Delete Q Search.
|
uuio
CANCEL ADD
4 items

In the Name field, enter a name for the label. For example, MIP_EXAMPLE.

In the UUID field, enter the label UUID. For more information, see "Step 1 - Copy the
Microsoft Sensitivity label names and their UUIDs from Microsoft Purview" on page 130.

Click Add.
Click OK.
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o Note - The newly created label is now listed in Sensitivity Labels under Data
Type Name section.
It also shows the label details:
® Date modified
® Description
® Tags - Shows tags assigned, if any, for further categorization
® Where used - Shows the DLP rule name that uses this label to enforce
protection.
® Groups - Shows if the label is part of any group.
You can use Tags and Groups to better organize and manage the sensitivity
labels.

@ CHECK POINT
@ tHarmony endpoint

Last update 8 Oct 2024 12:35 PM

-3 3 Data type not associated to any tag yet

@ Label

Data type in use within the application policy.

» Check Point Recommended

9. To edit alabel, select the label you want to edit, click Edit, update the field and then click
Apply.

CANCEL APPLY

10. To delete a label, select the label you want to delete, click Delete and then click Delete
Data Type.
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Deleting a data type X

You are about to delete "Test"

Note this cannot be undone.

CANCEL DELETE DATA TYPE

11. Click Save.

There is 1 change detected X

Saving the objects will store the updated information in the
database permanently. Are you sure you want to proceed with
saving all changes?

CANCEL CONFIRM

12. Click Confirm.

Step 3 - Assign Sensitivity Labels to DLP Rules

After creating Sensitivity labels in Harmony Browse, you must assign them to the DLP rules to
enforce data protection based on these sensitivity labels.

To assign sensitivity labels to a DLP rules, see "Creating a DLP Rule and Associating with an
Event" below.

Creating a DLP Rule and Associating with an Event

1. Goto Policy > Data Loss Prevention.

2. Add arule:
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a. Selectarule.

b. Click Clone and click Clone Above or Clone Below.

[ISSPYR IR © irscoi Foicy

o Note - If you have selected the default rule, select Clone Above.

The Clone Rule window appears.

CLOME RULE X

Search for Entity... o

*» Select from organization tree
Affected Devices (0) o~

Clone Configuration From ~

CANCEL

c. Inthe Name field, enter a rule name.
d. From the Applied to list, select a device(s) to which you want to apply the rule.
e. Click OK.

3. Toenable the Gen Al protection:
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Select the rule to which the Gen Al protection must be associated.

c o

From the list of tabs, select Settings tab.

o

Select Enable GenAl protect.
d. Click Save & Install, to apply the rule on the applicable endpoints.
4. Click one of these tabs:

® Outbound events - Outbound data refers to transferring content to external
resources.

Examples:
» Uploading file to a file sharing website.
» Entering text in a text box of an external resource, such as ChatGPT.

» Pasting text in a text box of an external resource, such as ChatGPT.

Note - Enforcement of DLP for Paste and Text Control events is only
supported for Generative Al sites.

® |nbound events - Inbound data refers to downloading data and sharing content
within internal corporate resources.

Example - Downloading file from a file sharing website.

U]

[«
a1 - -1 - | - | > |
£ : . -
H

e e el

annnnnaH

.
]

5. Click Add.

The Data Protection - New Event window appears.

Harmony Browse Administration Guide | 138



Web and Files Protection

= m data protection - Mew event

| @
Filz JE_: =d - ECEl:Eg-: ry _ b
o i _x o ]
'.-' I;'re-.-ert -
+ 0 Search =

6. By default, the event is enabled. To disable, turn off the Status toggle button.

7. From the Event type list, select one of these:

Event Type Appliesto Description

File upload | Outbound To apply the DLP rule when you upload a file to an
events external resource.

Text control | Outbound To apply the DLP rule when you type text in an external

events resource text box. For example, in ChatGPT.
Paste Outbound To apply the DLP rule when you paste content into an
events external resource. For example, ChatGPT.
File Inbound To apply the DLP rule when you download a file from
download events an internal resource.
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Event Type Appliesto Description

Copy Inbound To apply the DLP rule when you copy content from an
events internal resource.

Note - Enforcement of DLP for Paste and Text Control events is only supported
for Generative Al sites.

8. From the Destination type list, select one of these type to which you want to apply the

rule:

Destination

type Applies to Description
All File upload N/A
Url ® File upload In the URL field, enter the
® Fijle download | web addresses to which you
= Copy want to apply the rule.
Application ® Text control In the Applications field,
® Paste select the application(s) to
which you want to apply the
rule.
Domain ® File upload In the Domain field, enter
® Fijle download | the domain to which you
= Copy want to apply the rule.
Category ® File upload From the Categories & sub
® Text control categories list, select one
® Paste or more categories.
Notes:

® |n Inbound events, you can only choose a URL or Domain.
® |nInbound events, if a source is added for DLP scanning, files
downloaded from that source are not scanned by Threat Emulation.

9. From the Action list, select one of these:

® Detect - Performs the DLP scan but does not block the data.

® Prevent - Performs the DLP scan and prevents data transfer if it finds a match to a
data type.

® Allow - Acts as exclusions, allowing data transfer in certain events.

® BJlock - Blocks the data without the DLP scan.
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® Ask - Asks the user to provide justification before allowing data transfer based on
the DLP scan results.

To associate data types with an event, in the Data types section, click + and select the
data type or a group.

oNote - This step is applicable only if the Action is Ask, Detect or Prevent.

Click Save.

The events are displayed in the Outbound events and Inbound events columns in the
DLP rule.

To delete an event, select the event that you want to delete and click Delete.

To edit an event, select the event that you want to edit, click Edit, make the required
changes and click OK.

To disable all events, turn off the Disable all toggle button.
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] @ CHECKPOINT
@ Harmony Endpoint

W Deeie | @ DLP Data Type Manager | Searchfor Encry (PSSR I © insci Poicy

« Pase
« Fle uplosd 1P Address .-

© Fle uplase A © Biock
e} File upload @ Pre
«© Fle uplase ® e
« Fle uplosd Des
« Textconmrol P Adh . Fe

15. Click Save & Install.

The Install Policy window appears.

INSTALL POLICY x

Changed Rules Settings (1)
Rule Name Policy Type Changes Modified On Modified By

| Default settings for the entire organization Threat Prevention Settings were changed 1/17/2024. 11:16:46 AM

CANCEL INSTALL

16. Click Install.

Rule Configuration Logic

The rule configuration logic offers a systematic method for applying policy rules to events. The
system prioritizes the most specific events and progresses through these levels of specificity:

1. URL

2. Application
3. Domain
4. Category
5. All
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Note - The Paste and Text control events have access only to the Application and
Category levels.

Scenarios

n Status Event Destinations Data types Action
('. File upload Al ABA Transit Numbers Detect
& File upload https/fdomain.com/url1 html /A Q siock
& File upload https/fdomain.com/ur2. html FliA @ Alow
[ @ File upload domazini.com PCI - Card Security Code W FPreven:
[ @ File upload Computers{ Internet NI @ Allow
[ @ File upload Education A ® siock
( Paste ChatGPT IF Address . Prevent
( Fazte Artificial Intelligence (Al) MIA ® Slack
( Faste Grammiarly Secret APl Key - I

Scenario 1: User attempts to upload afile to https://domainl.com/urll.html

Specific Event
Most specific event is the URL https.//domain1.com/url1.html.

Result

Action - Block
System checks the
URL in the DLP Rule
base

s rule available in the rule base matching the
specified URL?

User attempts to upload a file to

https://domainl.com/url1.html Yesp-|  Upload of the file is

blocked without
scanning the file
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Scenario 2: User attempts to upload a file to https://domainl.com/url2.html

Specific Event
Most specific event is the URL https.//domain1.com/url2.html.

Result

Action - Allow

System checks the
URL in the DLP Rule
base

User attempts to upload a file to
https://domainl.com/url2.html

s rule available in the rule base matching the

specified URL? Yes Upload of the file is

allowed without
scanning the file

Scenario 3: User attempts to upload a file to https://domainl.com/url3. html

Specific Event
Most specific event is the Domain domain1.com.

Result

System checks the
URL in the DLP Rule
base

User attempts to upload a file to
https://domain1.com/url3.html|

s rule available in the rule base matching the
specified URL?

Action - Prevent

Uploaded file is
scanned, and if it
contains PCI - Card
Security Code

Is rule available in the rule base matching the
Domain?

information, the upload
is prevented

Scenario 4: User attempts to upload afile to https://domain2.com/url.html

Specific Event

The Category of domain?2 . comis Computers / Internet.

Since there are no specific events for the URL or Domain, the Category event is selected.
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Result

System checks the
—» URL in the DLP Rule
base

User attempts to upload a file to

s rule available in the rule base matching the
https://domain2.com/url.html

specified URL?

Is rule available in the rule base matching the
Domain?

Action - Allow

Is rule available in the rule base matching the URLF

Category? Upload of the file is

allowed without

scanning the file

Scenario 5: User attempts to upload afile to https://domain3.com/url.html

Specific Event

The Category of domain3. comis Education.
Since there are no specific events for the URL or Domain, the Category event is selected.

Result

System checks the
URL in the DLP Rule
base

User attempts to upload a file to

s rule available in the rule base matching the
https://domain3.com/url.html

specified URL?

Is rule available in the rule base matching the
Domain?

Action - Block

Is rule available in the rule base matching the URLF

Category? Yes Upload of the file is

blocked without

scanning the file

Scenario 6: User attempts to upload a file to https://domain4.com/url.html
Specific Event

Since there are no specific events for the URL, Domain, or Category, the event with the
destination All is selected.
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System checks the
»| URL in the DLP Rule
base

User attempts to upload a file to
https://domaind.com/url.html

S rule available in the rule base matching the
specified URL?

No Is rule available in the rule base matching the

s rule available in the rule base matching the URLF
Category?

Action - Detect

Uploaded file is
scanned and if it
contains ABA Transit
Yes—>| Numbers information,
the file is not

prevented but a log

with action Detect is

sent to the admin

Is there a general ALL rule?

Scenario 7: In Grammarly, user attempts to paste a secret AP| Key

Specific Event

Most specific event is the ApplicationGrammarly.

Result

In Grammarly, user attempts to

paste & text that contains a secret Is rule available in the rule base matching

the Application?

API Key

.

Text is pasted

Action = Ask

Is rule available in the rule base matching
the Category?

Text is scanned if it
contains a secret AP1
Key and prompt for
justification is shown

Text is blocked
Dy ——

Scenario 8: In ChatGPT, user attempts to paste the text that do not contain an IP address

Specific Event

Most specific event is the Application ChatGPT.

Result

In ChatGPT, user attempts to
pastes the text that do not contain

——
an IP Address the Application’

Is rule available in the rule base matching

Text is scanned if it
contains an IP

Action - Allow
Text is pasted

Is rule available in the rule base matching

the Category?
= Address

Action - Prevent
Text is scanned by
DLP and prevented
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Scenario 9: In ChatGPT, user attempts to paste the text that contain an IP address

Specific Event
Most specific event is the ApplicationChatGPT.

Result

In ChalGPT, user attempls to
pastes the text that contain an IP
Address

Text is scanned if it Action - Prevent
Yes. contains an IP fes. Text is scanned by
Address

Is rule available in the rule base matching
the Application?®

Is rule available in the rule base matching
the Category?

DLP and prevented

Scenario 10: In Gemini, user attempts to paste the text that do not contain an IP address

Specific Event
Most specific event is the CategoryArtificial Intelligence (Al).

Result

In Gemini, user tries to pastes the
text that do net contain an P
Address

Text is scanned if it Action - Block
Yes. contains an IP Yes. Text is blocked
Address without DLF scan

Is rule avallable in the nule base matching
the Application?

15 rile available in the rule base malching
the Category?

When multiple events are relevant for the same incident, the events with the strict action is
selected.

n Status Event : Destinations Data types
( domaini.com PCl - Card Security Code
( Computers / Internet MfA
[ 8 File upload Education MiA
[ & File upload doamini.com IP Address Dretect

Scenario 11: User attempts to upload a file to https://domain5.com/url.html

Specific Event

The Category of domain5 . com are Computers / Internet and Education.

Since there are no events for the URL or Domain, only two events for the Category are
relevant, and the system selects the event with stricter action.
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Result

System checks the
»| URLin the DLP Rule <
base

User attempts to upload a file to

16 rule available in the rule base matching the~
hitps://domains.comiurl.html

specified URL? o

No, s rule available in the rule base matching the
> omain:

Action - Allow

No__~5 ule available n the rule base matching the URLF™
- S uie avalable n e rie bass maiching the >—Yesp-¢ Computers / Internet or Education? >-Computers / Internets  Upload of the file is
N ~ allowed without

- ~ ~ scanning the file Action - Block
g ~__— > System selects the
_ N event with strict action,
Action - Block Block

Education——  Upload of the file is
blocked without
scanning the file

Scenario 12: User attempts to upload a file to https://domainl.com
Specific Event

Since there are no events for the URL, only two events for the Domain domaini.com are
relevant.

Result

System checks the
» URLin the DLP Rule
base

User attempts to upload a file to

S ule available in the rule base matching the
hitps://domain1.com

specified URL?

Action - Prevent

Is rule available in the rule base matching the’

Contains PCI - Card Security Code?
Domain?

Yes. File is prevented

Action - Detect

An alert is sent to the

2
Contains IP Address? admin

Yes.

The file is neither
prevented nor an alert
is sent
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General Information

Localization

The Harmony Browse extension automatically detects the language of the browser and
translates the following to the detected language:

Pop-up and associated notifications

Block pages

Note - The customized parts of a block page are not translated. For more
information, see "Configuring Client Settings Policy" on page 50.

OS notifications

The supported languages for localization are:

Czech

Danish

German

Greek

English

Spanish (European and Latin American)
Finnish

French

Italian

Japanese
Norwegian Bokmal
Dutch

Norwegian Nynorsk
Norwegian

Polish

Portuguese (European and Brazilian Portuguese)

Romanian
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B Russian

® Swedish
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Managing Active Directory
Scanners

If your organization uses Microsoft Active Directory (AD), you can import users, groups,
Organizational units (OUs) and computers from multiple AD domains into the Harmony
Browse. After the objects are imported, you can assign policies.

When you first log in to Harmony Browse, the AD tree is empty. To populate the tree with
computers from the Active Directory, you must configure the Directory Scanner.

The Directory Scanner scans the defined Active Directory and fills the AD table in the Asset
Management view, copying the existing Active Directory structure to the server database.

Harmony Browse supports the use of multiple AD scanners per Active Directory domain, and
multiple domains per service.

Required Permissions to Active Directory:

For the scan to succeed, the user account related to each Directory Scanner instance requires
full read permissions to:

® The Active Directory root.
® All child containers and objects.
® The deleted objects container.

An object deleted from the Active Directory is not immediately erased, but moved to the
Deleted Objects container.

Comparing objects in the AD with those in the Deleted objects container gives a clear picture
of network resources (computers, servers, users, groups) that have changed since the last
scan.

The Active Directory Scanner does not scan Groups of type "Distribution”.

Organization Distributed Scan

Organization Distributed Scan is enabled by default. You can see its configured settings in the
Endpoint Settings view > AD Scanners.

Full Active Directory Sync

In the Full Active Directory Sync, one Endpoint client is defined as the Active Directory
scanner, it collects the information and sends it to the Security Management Server.
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To download Endpoint client to be defined as an AD scanner:

1. Go to the Overview tab.

2. Click on the Download button in the blue bar.

3. Click on the Download button under the Client for AD integration.

To configure the AD scanner:

1. In the left navigation panel, click Asset Management.

2. Inthe left pane, click Computers.

3. Inthe top toolbar, click Computer Actions > in the section General Actions, click

Directory Scanner.

The Scanner window opens.

4. Fill in this information:

SECTION

Connect from
computer

AD Login
details

AD
Connection

REQUIRED INFORMATION

Computer name - Select the computer
name which the AD integration client
was installed on. This computer will be
used as your AD scanner.

User name (AD) - Enter the user name
to access the Active Directory.

Domain name - Enter the domain of the
Active Directory.

Password (AD) - Enter the password to
access the Active Directory.

Domain controller - Enter the name of
the Domain controller.

Port - Enter the number of the listening
port on the Domain controller.

Use SSL communication
(recommended) - Select this checkbox if
you want the connection between the AD
scanner to the Domain Controller to be
over SSL.

LDAP Path - The address of the
scanned directory server.

Sync AD every - Configure the interval
at which the scanning will be performed
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When you create a new AD scanner, the Organization Directory Scan is automatically
disabled.

To see information on your activated AD scanners, go to the Endpoint Settings view.

Note - You can also reach scanner configuration form through the Endpoint Settings
view > Setup full Active Directory sync.
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Harmony Browse Logs

See all collected logs in the Harmony Browse Logs view:

B.. Origin Card »
O Sep2,2021 125515 PM 1] aq 106106 o
Log Info
@ Sep2,2021 12 9 =) 106106
Policy
@ Sep2,2021 12 9 Infor =} 1061.06
O sep2,2021 12 /] Info &g 106106 rotection Detail
O Sep2,2021 12 9 Infor = 106106 Traffi
O sep2,2021 12: o= Low o ¢ 106106 Fo Detail
O Sep2,2021 12: o= Low o 106106 e
O Sep2,2021 11 R = Low =5 106106
g @ Sep2,2021 11 %= Low =N 1061.06
L Full Disk Encryption  ® 70% @ Sep 2, 2021 10:54:12 AM o= Low . p— 7
& Vediz Encryption & . 1 212% O $ep2,2021 10 R = Low =Y 106106 .
es
S Smartbvent Client @ Sep2,2021 10: & Medium =}
O sep2,202110: 3 Informational o /
2fcatalog %2r33fa%3dgazi
O s5ep2,2021 10 = Low = e was veriied by Zero
@ sep2,2021 10 £ Low a
082 O sep2,2021 10: E.. Low 1=
Client ti
— O Sep2,2021 10 E.. Low )
\
= Low — 70.84% @ Sep2,2021 10: M @ Low =) 192.168.14 vior
Medium . 205% O 5ep2,2021100613AM  E.. Low @
Informational ¥ TAI% O Sep2,2021 95211 AM E. Low & g
High L 3.7% @ Sep 2,2021 93549 AM E. Low o g
et O Sep2,202192423AM  E.. Low @
Detect - 2017% O sep 2, 2021 922146 AM Ew Low =)
@ Allow — 2917% @ Sep 2,2021 8:47:00 AM E.. Low o g
@ Block - 250% O sep 2,2021 8:44:34 AM E.. Low & g
W Prevent . 833% @ sep 2, 2021 8- Eu Low =]
W Bxtract E 833% [ Low o 106106
~ —

® Feedback

Use the time filter (1) and select the relevant options on the Statistics pane (3) to set specific
criteria and customize the search results. Alternatively, you can enter your query in the search
bar. For more details about the Query Language, see "Query Language Overview" on

page 156.

Item Description

1 Time period - Search with predefined custom time periods or define another time
period for the search.

2 Query search bar - Enter your queries in this field.

3 Statistics pane - Shows statistics of the events by Blades, Severity of the event
and other parameters.

4 Card - Log information and other details.
5 Results pane - Shows log entries for the most recent query.

6 Options - Hide or show a client identity in the Card, and export the log details to
CSV.

The information recorded in logs can be useful in these cases:
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® To identify the cause of technical problems.
® To monitor traffic more closely.

® To make sure that all features function properly.

Note - You can forward logs to expansion (SIEM). For more information, see Event
Forwarding.

Harmony Browse Administration Guide | 155


https://sc1.checkpoint.com/documents/Infinity_Portal/WebAdminGuides/EN/Infinity-Portal-Admin-Guide/Content/Topics-Infinity-Portal/Event-Forwarding.htm
https://sc1.checkpoint.com/documents/Infinity_Portal/WebAdminGuides/EN/Infinity-Portal-Admin-Guide/Content/Topics-Infinity-Portal/Event-Forwarding.htm

Managing Active Directory Scanners

Query Language Overview

A powerful query language lets you show only selected records from the log files, according to
your criteria.

To create complex queries, use Boolean operators, wildcards, fields, and ranges.
This section refers in detail to the query language.

When you use Harmony Browse to create a query, the applicable criteria appear in the Query
search bar.

The basic query syntax is:

[<Field>:] <Filter Criterion>

To put together many criteria in one query, use Boolean operators:

[<Field>:] <Filter Criterion> {AND | OR | NOT} [<Field>:] <Filter
Criterion>

Most query keywords and filter criteria are not case sensitive, but there are some exceptions.
For example, "source: <x>"is case sensitive ("Source : <x>" does not match).

If your query results do not show the expected results, change the case of your query criteria,
or try upper and lower case.

When you use queries with more than one criteria value, an AND is implied automatically, so
there is no need to add it. Enter OR or other boolean operators if needed.

Criteria Values

Criteria values are written as one or more text strings.
You can enter one text string, such as a word, IP address, or URL, without delimiters.

Phrases or text strings that contain more than one word must be surrounded by quotation
marks.

One-word string examples

® John

® inbound

192.168.2.1

B some.example.com
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® dns udp
Phrase examples

B "John Doe"
® "Tog Out"

B "VPN-1 Embedded Connector"

IP Addresses

IPv4 and IPv6 addresses used in log queries are counted as one word.
Enter IPv4 address with dotted decimal notation and IPv6 addresses with colons.
Example:

m 192.0.2.1

® 2001:db8::£00:d

You can also use the wildcard'*' character and the standard network suffix to search for
logs that match |P addresses within a range.

Examples:
" | 5rc:192.168.0.0/16
Shows all records for the source IP 192.168.0.0 to 192.168.255.255 inclusive
" | src:192.168.1.0/24
Shows all records for the source IP 192.168.1.0 to 192.168.1.255 inclusive
" | src:192.168.2.%
Shows all records for the source IP 192.168.2.0 to 192.168.2.255 inclusive

® 0 192.168.%

Shows all records for 192.168.0.0 to 192.168.255.255 inclusive
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NOT Values

You can use NOT <field> values with Field Keywords in log queries to find logs for which the
value of the field is not the value in the query.

Syntax:

NOT <field>: <value>

Example:

NOT src:10.0.4.10

Wildcards

You can use the standard wildcard characters (* and ?) in queries to match variable
characters or strings in log records.

You can use more than the wildcard character.

Wildcard syntax:
® The ? (question mark) matches one character.

® The * (asterisk) matches a character string.

Examples:
® Jo? shows Joe and Jon, but not Joseph.
® Jo* shows Jon, Joseph, and John Paul.
If your criteria value contains more than one word, you can use the wildcard in each word.

For example, 'Jo* N*'shows Joe North, John Natt, Joshua Named, and so on.

o Note - Using a single '+' creates a search for a non-empty value string. For example
asset name:*
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You can use predefined field names as keywords in filter criteria.

The query result only shows log records that match the criteria in the specified field.

If you do not use field names, the query result shows records that match the criteria in all fields.

This table shows the predefined field keywords. Some fields also support keyword aliases that
you can type as alternatives to the primary keyword.

Description

severity
app_risk
protection

protection
type

confidence

level
action
blade

destination

origin
service

source

user

product

dst

orig

SrcC

Severity of the event
Potential risk from the application, of the event
Name of the protection

Type of protection

Level of confidence that an event is malicious

Action taken by a security rule
Software Blade

Traffic destination IP address, DNS name or Check
Point network object name

Name of originating Security Gateway
Service that generated the log entry

Traffic source IP address, DNS name or Check Point
network object name

User name

Harmony Browse Administration Guide | 159



Managing Active Directory Scanners

Syntax for a field name query:

<field name>:<values>

Where:
® <field name> - One of the predefined field names
® <values> - One or more filters

To search for rule number, use the Rule field name.

For example:

rule:7.1

If you use the rule number as a filter, rules in all the Layers with that number are matched.
To search for a rule name, you must not use the Rule field. Use free text.

For example:

"Block Credit Cards"

0 Best Practice - Do a free text search for the rule name. Make sure rule names are
unique and not reused in different Layers.

Examples:
B source:192.168.2.1
B action: (Reject OR Block)
You can use the OR Boolean operator in parentheses to include multiple criteria values.
o Important - When you use fields with multiple values, you must:

® \Write the Boolean operator, for example AND.
® Use parentheses.
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Boolean Operators

You can use the Boolean operators AND , OR, and NOT to create filters with many different
criteria.

You can put multiple Boolean expressions in parentheses.
If you enter more than one criteria without a Boolean operator, the AND operator is implied.

When you use multiple criteria without parentheses, the OR operator is applied before the
AND operator.

Examples:

" | blade:"application control"™ AND action:block

Shows log records from the Application and URL Filtering Software Blade where traffic
was blocked.

" 192.168.2.133 10.19.136.101
Shows log entries that match the two IP addresses. The AND operator is presumed.

® 192.168.2.133 OR 10.19.136.101

Shows log entries that match one of the IP addresses.

" (blade: Firewall OR blade: IPS OR blade:VPN) AND NOT
action:drop

Shows all log entries from the Firewall, IPS or VPN blades that are not dropped.

The criteria in the parentheses are applied before the AND NOT criterion.

" source: (192.168.2.1 OR 192.168.2.2) AND destination:17.168.8.2

Shows log entries from the two source IP addresses if the destination IP address is
17.168.8.2.

This example also shows how you can use Boolean operators with field criteria.
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Managing Virtual Groups

Virtual Groups manage groups of users and devices.

You can use Virtual Groups with Active Directory for added flexibility or as an alternative to
Active Directory.

Objects can be members of more than one virtual group.

The benefits of using Virtual Groups include:

Using the Active Directory without using it for Endpoint Security.

For example: Different administrators manage the Active Directory and Endpoint
Security.

Your Endpoint Security requirements are more complex than the Active Directory
groups. For example, you want different groups for laptop and desktop computers.

Using a non-Active Directory LDAP tool.
Working without LDAP.

Some virtual groups are pre-defined with users and devices assigned to them automatically.

To create a virtual group:

1.

2
3.
4

Access Harmony Browse and click Asset Management.

. Go to Organization > Organizational Tree and select Virtual Groups.

To create a virtual group for a group, right-click a group.

. To create a virtual group for a specific device or a user, click the group and right-click the

device or user.
Select Create Virtual Group.

The Create Virtual Group window appears.
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CREATE VIRTUAL GROUP X

In the Name field, enter a group name.

7. (Optional) In the Comment field, enter a comment.

8.

Notes:
® A user or a device can belong to multiple virtual groups.

® Selecting a certain user or device shows the Active Directory information
collected about them.

® You cannot edit Active Directory groups but you can view their content.
® You can create a group and then assign the users or devices to the group,
or select users or devices first and then create a group from them.

Click OK.

Note - You can also perform this procedure from Asset Management >
Organization > Computers. See "Managing Computers" on page 46.

To add a group, device or a user to a virtual group:

1.

Access Harmony Browse and click Asset Management.

. Go to Organization > Organizational Tree and select Virtual Groups.

2
3.
4

To add a group to a virtual group, right-click a group.

. To add a specific device or a user to a virtual group, click the group and right-click the

device or user.
Select Add to Virtual Group.
The Add Members to Virtual Group window appears.
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ADD MEMEERS TO VIRTUAL GROUP x

Select virtual Group:

6. Select the applicable virtual group.
7. Click OK.

o Note - You can also perform this procedure from Asset Management >
Organization > Computers. See "Managing Computers" on page 46.

To create and add to virtual group:

1. Access Harmony Browse and click Asset Management.

2. Go to Organization > Organizational Tree and select Virtual Groups.
3. Tocreate and add a group to a virtual group, right-click a group.
4

. To create and add a specific device or a user to a virtual group, click the group and right-
click the device or user.

5. Select Create and Add to Virtual Group.

The Add Members to Virtual Group window appears.
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ADD MEMEERS TO VIRTUAL GROUP x

In]

In the Name field, enter a group name.
(Optional) In the Comment field, enter a comment.
In the Members section search box, search and select the member.

Click OK.

© © N o

Note - You can also perform this procedure from Asset Management >
Organization > Computers. See "Managing Computers" on page 46.

To move devices from one virtual group to another:
1. Inthe left navigation panel, click Asset Management.
2. Inthe left pane, click Organization > Organizational Tree.
3. Click Virtual Groups.
4. Move the devices:
® To move all the devices from a virtual group, select the virtual group.

® To move specific devices from a virtual group, click the virtual group, and select the
devices.

5. Right-click the virtual group or devices and select Move to Virtual Group.
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The Move Members to Virtual Group window appears.
6. Select the virtual group where you want to move the devices.

7. Click OK.

To export the list of devices in a virtual group to an excel file:

1. From the left navigation panel, click Asset Management > Organization > Organization
Tree.

2. From the list, click Virtual Group.
3. Right-click the virtual group and select Export Virtual Group Report.

The system exports the list of devices to an excel file. If the virtual group contains child
virtual groups, then the devices in those virtual groups are also included in the exported
file.
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Exporting Logs

Check Point Log Exporter is an easy and secure method to export Check Point logs over
syslog. Log Exporter is a multi-threaded daemon service which runs on a log server. Each log
that is written on the log server is read by the Log Exporter daemon. It is then transformed into
the applicable format and mapping and sent to the end target.

For more information, see sk122323.

To export logs from Harmony Browse:

1. Go to Endpoint Settings > Export Events.

2. Click Add.

The New Logging Service window opens.

3. Fillin the export details:

Name - Enter a name for the exported information.

IP Address - Enter the IP Address of the target to which the logs are exported.
Protocol - Select the protocol over which to export the logs: TCP or UDP.
Format - Select the export format.

Port - Select the port over which to export the logs. Only these ports are supported
for outgoing communication: 514, 6514, 443.

TLS/SSL - Select this checkbox if you want log information to be TLS/SSL
encrypted. The only allowed authentication method through TLS is mutual
authentication. For mutual authentication, the log exporter needs these certificates:

» A *.pem Certificate Authority certificate (must contain only the certificate of
the CA that signed the client/server certificates, not the parent CA).

» A*.p12format client certificate (log exporter side).

For instructions on how to create the certificates, see "Creating Security
Certificates for TLS Mutual Authentication" below.

4. Click Add.

Creating Security Certificates for TLS Mutual
Authentication

This section explains how to create self-signed security certificates for mutual authentication.
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o Notes:

Exporting Logs

® Make sure to run the openss1 commands on a 3rd party CA server (not on the
log exporter device). The log exporter device must have a connectivity to the CA

server.

® The commands are not supported on a Check Point Security Management
Server or a Multi-Domain Server.

Procedure

1. Create a CA certificate

Step Description

1

Generate the self-signed root CA key:

openssl genrsa -out ca.key 2048

Generate the root CA certificate file in the PEM format:

openssl req -x509 -new -nodes -key ca.key -days 2048 -out ca.pem

Enter the information regarding the certificate.

This information is known as a Distinguished Name (DN).

An important field in the DN is the Common Name(CN), which should be the exact Fully Qualified Domain Name
(FQDN) of the host, with which you intend to use the certificate.

Apart from the Common Name, all other fields are optional and you can skip it.

If you purchase an SSL certificate from a certificate authority, it is often required that these additional fields, such
as "Organization", accurately reflect your organization's details.

o Best Practice - Use the device IP address as the Common Name.

2. Create a client certificate

Step Description

1

Generate a client key:

openssl genrsa -out cp
client.key 2048

Generate a client certificate sign request:

openssl req -new -key cp_
client.key -out cp client.csr

Sign the certificate using the CA certificate files:

openssl x509 -req -in cp
client.csr -CA ca.pem -CAkey
ca.key -CAcreateserial -out
cp_client.crt -days 2048 -
sha256
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Step Description

4

Convert the certificate to the P12 format:

openssl pkcsl2 -inkey cp_
client.key -in cp client.crt -
export -out cp_client.pl2

Note - The challenge phrase used in this
conversion is required in the cp
client TLS configuration.

3. Update the security parameters on the Check Point exporting server

Step Description

1

On a Multi-Domain Server or Multi-Domain Log Server, go to the context
of the applicable Domain Management Server or Domain Log Server:

If you run on a Multi-Domain Log Server/Multi-Domain Log Server, run
this command to switch to the required domain:

mdsenv <Name or IP Address of Domain Management
Server or Domain Log Server>

Go to the deployment directory:
cd SEXPORTERDIR/targets/<Deployment Name>/

Create a directory for the certificate files:

mkdir -v certs

Copy the ca.pemand cp client.pl2 certificate files to the
SEXPORTERDIR/targets/<Deployment Name>/certs/ directory.

o Note - The ca . key must not be published.

Assign the read permissions to the ca.pemand cp client.pl2
certificate files:

chmod -v +r ca.pem
chmod -v +r cp client.pl?2

Update the secured target:

cp log export set name <Name> domain-server
<Domain-Server> encrypted true ca-cert <Full Path
to CA Certificate *.pem File> client-cert <Full
Path to *.pl2 Certificate File> client-secret
<Challenge Phrase for the *.pl2 File>
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4. Create a server (target) certificate

Step Description

1

Generate a server key:

openssl genrsa -out server.key
2048

Generate a server certificate sign request:

openssl req -new -key server.key
-out server.csr

Sign the certificate using the CA certificate files:

openssl x509 -req -in server.csr
-CA ca.pem -CAkey ca.key -
CAcreateserial -out server.crt -
days 2048 -sha256

Note - Some SIEM applications require the server certification to be in a
specific format. For more information, refer to SIEM Specific Instructions
section (sk122323).
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Sending Security Reports

You can send weekly and monthly security report to all the administrators by email. The
security report contains a summary of events detected and prevented by Harmony Browse.

To send weekly and monthly security reports to all administrators by email:
1. Click Endpoint Settings > General Settings:

® To send weekly reports, toggle Send weekly security report by email to all
administrators to ON.

® To send monthly reports, toggle Send monthly security report by email to all
administrators to ON.
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Reports Center

The Reports Center provides you with the insights of the security analysis detected by the
endpoint. These reports can be generated and scheduled.

Generate Report

To view predefined reports, navigate to Endpoint Settings > Reports Center > Generate
Report.

You can download these reports in the pdf format:
® Security Checkup - A comprehensive report on security events.
® Threat Extraction - Shows the insights on the downloaded files.

® Check Point Cyber Security Report 2023 - Shows the insights to help your organization
stay secure.

To download a report:
1. Select the report and click Export Report.
The Export Report window appears.
2. Inthe Time Frame list, select Last day, Last 7 days, or Last 30 days.
3. Click Export.

Schedule Report

Schedule Report allows you to automatically generate reports at the specified date and time,
and email it to the specified recipients.

o Notes:

® The report becomes effective 24 hours after you schedule it. For example, if you
schedule for a new report today for 02:00 PM, then it is enforced from the next day at
02:00 PM.

® This feature is not supported for Check Point Cyber Security Reports.

® For performance reasons, it is recommended to schedule reports to run in off-peak
hours. For example, during non-business hours.

® The default time zone for the schedule report is Coordinated Universal Time (UTC).
For example, to schedule the report at 1:00 AM EST, specify the time as 6:00 AM
(depending on Daylight Savings Time).
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To schedule a report:

—

. Navigate to Endpoint Settings > Reports Center > Schedule Report.
. Click Add.

The Schedule Report window appears.
From the Name list, select the report.
From the Time Frame list, select the period for the report:
® | ast day
® | ast 7 days
® | ast 30 days
From the Frequency list, select the frequency to generate the report:
® To generate the report everyday, select the day of the week.
® To generate the report weekly, select the day of the week.
® To generate the report every month, select the date.

In the Time field, specify the time for the system to generate the report and send it to the
recipients. By default, the time is in UTC. For example, if you want to generate the report
at 01.00 AM Eastern Standard Time (EST), you must specify the time as 06.00 AM UTC.

In the Recipients field, enter the recipients for the report.
Click Schedule.

The schedule is added to the table. The report becomes effective 24 hours after you
schedule it.

To edit a scheduled report, select the report in the table and click Edit.

. To delete a scheduled report, select the report in the table and click Delete.
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Uninstalling the Harmony Browse
Extension

For more information, see sk180608.
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